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PREFACE About This Document

NetQoS NetVoyant is a powerful performance analysis and reporting software package that

automates the collection, analysis, and reporting of critical device data. Using Simple Network

Management Protocol (SNMP), the NetVoyant product automatically polls and correlates data from

devices installed on your network. Data from routers, switches, servers, RMON2 probes, frame relay

circuits, logical segments, and wide area links are collected and organized to give you real information

about your network. You can easily identify trends and issues before they become problems.

This document provides information and procedures to help you perform administrative tasks in the

NetVoyant product effectively.

Chapter

Description

Chapter 1, “NetVoyant System Setup”
on page 15

Chapter 2, “Configuring Your
NetVoyant System” on page 31

Chapter 3, “Configuring Data Collection
and Retention” on page 67

Chapter 4, “Managing Your Devices and
Networks” on page 115

Chapter 5, “Working with Management
Information Bases” on page 177

Chapter 6, “Managing NetVoyant Events
and Alarms” on page 189

Chapter 7, “Managing Notifications” on
page 225

Chapter 8, “Configuring IP SLA
Operations” on page 255

Chapter 9, “Managing NetVoyant
Services” on page 279

Chapter 10, “Reporting Administration”
on page 287

Introduces you to NetVoyant administration in the NetVoyant
Console.

Describes how to use the Configuration Wizard to perform the
initial configuration of the NetVoyant product.

Describes how to manage datasets and configure how the
NetVoyant product collects and retains SNMP data from your
devices.

Describes how to manage groups, devices, poll instances, and
interfaces in the NetVoyant Console.

Describes how to use Management Information Bases (MIBs)
in the NetVoyant Console to control what types of SNMP data
NetVoyant can collect from your devices.

Describes how to manage NetVoyant events and alarms and
how to view information in event logs.

Describes how to configure and manage notifications that the
NetVoyant product sends in response to events on your
network.

Describes how to configure Cisco I0S IP SLLA operations for
your Cisco devices using the IP SLA Wizard.

Describes how to start and stop NetVoyant services and
configure database logging.

Describes administration tasks in the NetVoyant reporting
interface, such as adding NetVoyant user accounts and
configuring an SMTP server.

NetVoyant 7.0 Administrator Guide
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About This Document

Chapter Description

Appendix A, “NetVoyant Properties and ~ Describes NetVoyant properties and operators, which you can
Operators” on page 307 use when writing expressions and thresholds.

Appendix B, “Managing NetVoyant Describes how to configure the NetVoyant product to send and
SNMP Traps” on page 323 receive SNMP traps.

RELATED DOCUMENTATION

In addition to this book, you can find useful information in the following publications:

Document Description

NetVoyant User Guide This guide provides information and procedures to help you
effectively use the NetVoyant reporting interface.

NetVoyant v7.0 Release Notes Summarizes product enhancements, fixes, and open issues.

NetVoyant v7.0 online Help Provides context-sensitive help for tasks that you perform

through the NetVoyant Console and web reporting tool.

You can access the product documentation in the following ways:

In the NetVoyant web reporting tool, navigate to the About page in the product and click the User
Guide link.

Navigate to the Documentation directory on the server, which contains the PDF files for both
the User Guide and Administrator Guide, as well as supplemental documentation.

The product documentation is available in PDF format on the server where the NetVoyant
product is installed. Find the PDF files in the following location:

D:\NetVoyant\Portal\WebSite\Docs

On the desktop of the server, find shortcuts that link to the User Guide and Administrator Guide
PDF files.

The current versions of the PDF files for the product documentation, including the Re/ease Notes, are

always available on the NetQoS Self-Service Portal.

CONVENTIONS

The following conventions are used in this book:

In instructional text, boldface type highlights information that you enter or GUI elements that you
select.

All syntax and literal examples are presented in monospace typeface.

In syntax, path names, or system messages, text enclosed in angle brackets (<>) represents a
variable as shown in the following example:

net time/setsntp: <utpserver>

12

NetVoyant 7.0 Administrator Guide



About This Document

PROVIDING DOCUMENTATION FEEDBACK

We want to help you use our products effectively so that you can work quickly and efficiently. By
telling us about your experience with this document, you can help us achieve that goal. Send an email
message with your feedback to our technical publications team at the following address:
docfeedback@netqos.com
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CHAPTER | NetVoyant System Setup

The NetVoyant product is a powerful performance analysis and reporting software package that
automates the collection, analysis, and reporting of critical device data. Using Simple Network
Management Protocol (SNMP), it automatically polls and correlates data from devices installed on
your network. Data from routers, switches, servers, RMONZ2 probes, frame relay circuits, logical
segments, and wide area links are collected and organized to give you real information about your
network. You can easily identify trends and issues before they become problems.

This chapter provides information about the initial installation and configuration of the NetVoyant
product and provides helpful tips and tricks for working in the NetVoyant Console.

This chapter covers the following topics:
= “NetVoyant Architectural Overview and Licensing” on page 16
= “About the Master Server and Pollers” on page 21

* “Operational Requirements” on page 17

= “About NetVoyant Administration” on page 23

NetVoyant 7.0 Administrator Guide 15



NetVoyant System Setup

NETVOYANT ARCHITECTURAL OVERVIEW AND LICENSING

The NetVoyant product can operate on a single server (standalone system) or on multiple servers
(distributed system). To determine which of these systems is best for your organization, you must
consider the overall structure of your network, the devices you want to discover, and the licensing
requirements.

NetVoyant Standalone System

In a standalone configuration, you set up one NetVoyant server called the Master. All administration,
reporting, and polling takes place on the Master server. For a standalone NetVoyant system, there is
one license for the entire system.

NetVoyant Distributed System

In a distributed system, also known as NetVoyant Enterprise, you set up a central server for
administration and reporting called the Master. You then set up remote servers, called po/lers, from
which the NetVoyant system discovers and polls the devices on your network. In distributed systems,
there is a license for the Master and separate licenses for each poller. The Master has a poll instance
license limit of zero poll instances and each poller has a limit according to the number of poll
instances that it is licensed to poll.

Using remote pollers in a distributed system makes it possible to monitor several remote data centers
and their associated LANs while preserving bandwidth. These remote servers poll and aggregate data
on a local level, and the data is retrieved by the central station and a network operations view of the
entire network can be seen. Conversely, when an alarm is received from a remote location, network
operations staff has the capability to drill down from data maintained on the central server to poll-rate
data at the remote site.

L _, Ty
nﬁ@ B €3 0

'olling Station

Central Console
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Operational Requirements

NetVoyant servers require 24-hour access to network devices. The computer should not be powered
down during off hours. For optimum performance, the network devices should be accessible through
LAN rather than WAN connections whenever possible.

Networking services must be configured and enabled for the software to operate correctly. This
includes TCP/IP and all configuration parameters. Access to a naming service, such as DNS, is
essential for the presentation of devices through the NetVoyant user interface components.

Many routers and other network connectivity devices require that the address of the “Manager” nodes
that will be polling the device be entered into the device’s access list. The access list typically contains
a list of trusted hosts that the device responds to via SNMP. Configuration of the access list is
typically performed via a proprietary interface to the device. Contact your device manufacturer for
questions about adding the NetVoyant host to the access list.

SNMP Profiles. SNMP profiles are used by SNMP Agents to verify the identity of requesting
managers. The NetVoyant product needs to know the read profiles supported by your network
devices for these devices to respond to discovery and polling, If you plan to configure IP SLA tests,
both the read and write profiles are required. The NetVoyant Console supports authentication to
devices using SNMPv1, SNMPv2, and SNMPv3.

Network Addresses and Masks. You will need to know about your network addresses and address
masks. It is important to “scope” the discovery process to those address spaces that you want to
manage. A network address (address space) is a network number such as 205.195.82.0. A network
mask for such an address might be 255.255.255.0. This example defines a Class C address space.
Normally, this example would be denoted as 205.195.82.0/24, with the /24 signifying the number of
bits dedicated to the network address.

Seed Devices for WAN Discovery. You might need to know the names or addresses of gateway or
backbone routers or other connectivity devices to provide the NetVoyant product with a “seed”
device. Seed devices are necessary when discovering networks that are separated from the NetVoyant
host via a public network or when a gateway router is not discoverable because of problems with
access lists or profiles. In these cases, NetVoyant will target discovery of network nodes through these
seed devices.

NetVoyant 7.0 Administrator Guide 17
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NetVoyant Licensing

Your NetVoyant license allows you to enable a set number of poll instances. The number of poll
instances that you have enabled in the NetVoyant product affects the amount of data that you can
collect from your devices.

In order to increase the number of poll instances that your NetVoyant system can poll, you must
upgrade your license; however, you can attempt other methods for managing your current license
limit of poll instances before requesting an upgrade. For more information about poll instances, see
“Data Organization by Poll Instance” on page 68.

Some NetVoyant products are licensed using a pre-configured USB HASP (Hardware Against
Software Piracy) according to the number of enabled poll instances in your environment. If you are
running the NetVoyant product under a HASP license, you must plug in the HASP before you boot
the NetVoyant machine for the first time.

Important: If you do not have the correct HASP or need an updated or upgraded license, contact

NetQoS Technical Support.

Licensing Differences Between Standalone and Distributed Systems

For a standalone NetVoyant system, there is one license with a maximum number of poll instances for
the entire system; however, in larger distributed NetVoyant systems, there is a license for the Master
server and separate licenses for each poller. By default, the Master has a license limit of 0 poll
instances and each poller has a limit according to the number of poll instances that it is licensed to

poll.

Viewing Your License Information

If you are considering whether you need additional NetVoyant licensing, you can open the License
Information dialog box to view the license information for your system. This dialog box displays the
number of discovered poll instances that are enabled and also the number of instances for which you
are licensed on each server in your system. Using this dialog box, you can track your licensing status
and requirements.

To view information about your NetVoyant license:
I. From the File menu in the NetVoyant Console, select License Info.
The License Information dialog box opens.

2. Select the Show details check box at the bottom of the dialog box to view detailed information
about how poll instances are enabled and discovered by dataset.

For example, license information for Interface Statistics (i fstats) reported as “1,792/1,806”
indicates that there are 1806 discovered poll instances for this dataset, but only 1792 are enabled.

18 NetVoyant 7.0 Administrator Guide
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[
License Information for neidddistpoll {Remote Poller)
License limit: 10,000
Enahled: 3,229
Dizcovered: 3,261
Enabled Poll Instances by Dataset:
Device Availability(svail): 20
Cizco Memory Pool{ciscoMemPoal): 25125
Cizco Backplane Traffic(cizcoSwitch): 1M
Cizco System Resources(ciscoSystem): a9
D=1 15-Minute Statistics(dsxnear): 2017201
D=3 15 Minute Statistics(dsx3near): 2004200
Ethernet RMOM Statistics(etherstats): B9JE9
Frame Relay Circuit Statistics(froircuit): 2004200
Host Resource Device Tablelhrdevice): 39439
Host Resource Processar Tablethrprocessor): 1313
Host Resource Storagelhrstorage): 39439
Host Resource Software Performancelhrswrun: MBI2E
Interface Statistics(ifstats): 1,7924 806
Protocol Distribution (NBARI(nbarstats): 160MED
Protocaol Distribution (RMONZI(protodist): [ufn)
QoS Class Map Statistics(gosclass): 22§22
G0S Police Color Statistics(goscolar): 212
Q0% P Header Compression Statistics{gosiphc): [ufn) LI
¥ Show licerse warrings at startup [

If you view your license information for a distributed system, the dialog box displays a 0 poll instance
license for the Master Console and details about poll instance limits and usage for each of the remote

pollers.

You can enable and disable poll instances from the NetVoyant Console to comply with your license
agreement. For more information, see “Managing Poll Instances” on page 20.

Note: It is possible to see a higher number of discovered poll instances than enabled poll instances
even if you have not disabled any. In this situation, there is one or more discovered poll instances that
has no associated dataset and acts as a parent to one or more enabled poll instances. The NetVoyant
product does not collect data for these parent poll instances and does not count them towards your
license total; therefore, they are discovered but not enabled.

Licensing by Poll Instance

Your NetVoyant license allows you to enable a set number of poll instances in the NetVoyant product.
The number of poll instances that you have enabled affects the amount of data that you can collect
from your devices.

In order to increase the number of poll instances that your system can handle you might need to
upgrade your NetVoyant system as well as purchase a larger license. However, you should attempt to
employ other methods for managing your current license limit of poll instances before requesting an

upgrade.

For more information about managing your poll instances and reduce collection of non-essential data,
see “Managing Poll Instances” on page 20.

If you need an upgraded license, please contact NetQoS Technical Support.

NetVoyant 7.0 Administrator Guide 19
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Disabling License Warnings

At startup, the NetVoyant Console displays warnings when you are close to exceeding your license

limit of poll instances, or have exceeded it. You can disable this option if you no longer want to see

these messages.

To disable license warnings:

I. From the File menu in the NetVoyant Console, select License Info.

The License Information dialog box opens.

2. Disable the Show license warnings at startup check box at the bottom of the dialog box.

3. Click Close.

Managing Poll Instances

Most datasets and device classes are enabled for polling by default. If there are enabled poll instances

that you do not need and you want to make poll instance licenses available for those that you do need,

you can disable polling for the following items in the NetVoyant Console to reduce the number of

currently enabled poll instances in your NetVoyant system:

Disable polling for...

More information

Datasets for which you are not interested in displaying
reports.

Groups for which you are not interested in displaying
reports.

An entire network for which you are not interested in
displaying reports.

Device classes or device models for which you atre not
interested in displaying reports.

Individual devices for which you are not interested in
displaying reports.

Interface types for which you are not interested in
displaying reports.

Individual interfaces or poll instances for which you are
not interested in displaying reports.

IP SLA operations for which you are not interested in
displaying reports.

Non-operational interfaces.

Interfaces that do not have any traffic.

“Enabling and Disabling Polling for
Datasets” on page 86

“Configuring Polling for a Group” on
page 123

“Configuring Polling for a Group” on
page 123

“Configuring a Polling Group for a
Network” on page 124

“Changing the Polling Status for a Device”
on page 148

“Performing Mass Operations by Interface
Type” on page 173

“Configuring Polling for Poll Instances and
Interfaces” on page 166

“Disabling Polling for an IP SLA
Operation” on page 271

“Disabling Polling for Non-Operational

Interfaces” on page 91

“Disabling Polling for Interfaces without
Traffic” on page 92
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Contacting Technical Support

If you have questions about the NetVoyant product or would like to upgrade your license, go to the
technical support page at:

http://www.netqos.com/support
This page provides the latest contact information for the Technical Support team.
If you do not have access to the Internet, use one of the following telephone numbers:

e United States or Canada: (877) 835-9575; Option 3.
* Outside the United States or Canada: (512) 407-9443; Option 3.

ABOUT THE MASTER SERVER AND POLLERS

The Master is the central NetVoyant server. In a standalone system, all administration, reporting, and
polling is done on or by the Master. In a distributed system, there is a central server for administration
and reporting called the Master and you then set up remote servers called pollers, which discover and
poll your network.

Adding Remote Pollers to a NetVoyant Distributed System

After you configure the Master server in a distributed system, you must add and configure the remote
servers, called po/lers, that discover and poll the devices on your network. You can add up to 15
pollers per Master.

Important: Many NetVoyant configuration tasks must take place on the Master server. Configuration
changes are synced from the Master to each connected poller. If configuration changes occur on the
Master when a poller is operationally down, the change will be synced to the poller when
communication with the Master is restored.

To add a poller to the Master:
I. Install the NetVoyant product on the poller server.
2. Open the NetVoyant Console application on the Master.

3. From the File menu, select New > NetVoyant Poller.

The Add Poller dialog box opens.

[ add poller [x]

Metwoyant Poller narme:

Uzername:

Pazsword:

Cancel | Help |
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4. Enter the following parameters:

Parameter Description
NetVoyant server name The poller’s IP address or fully qualified DNS name.
Username The username used to log in to the NetVoyant Console on the poller.

You can use the nvadmin user name, which is set as an administrator
user account by default.

Password The password used to log in for the user account on the poller.

If you are using the nvadmin user account, the password is set to nv by

default.

5. Click OK.

You can repeat this process for each poller that you want to add to the Master.

Configuring a Poller

After you add a poller to the NetVoyant Master server, you can assign devices to the poller from the
NetVoyant Console on the Master using the Configuration Wizard. You can change the assigned
poller for the existing items in the discovery scopes and discovery seeds lists, or add new items and
assign them to the new poller.

Important: Many NetVoyant configuration tasks must take place on the Master server. Configuration
changes are synced from the Master to each connected poller. If configuration changes occur on the
Master when a poller is operationally down, the change will be synced to the poller when
communication with the Master is restored.

To configure the pollers on the Master:
I. From the Tools menu, select Configuration Wizard.

2. Step through the wizard and complete the steps to specify the poller assigned to each item in the
discovery scopes and discovery seeds.

For more assistance with this step, see “Using the Configuration Wizard” on page 33.

Adding a Poller as Trusted Site

After you have configured the Master server and the pollers, you must add these servers as trusted
sites in Internet Explorer on the Master. This enables the NetVoyant reporting interface on the
Master server to display data from these servers.

To add a poller as a trusted site in Internet Explorer:
I. On the Master, open the Internet Explorer browser.
2. In Internet Explorer, select Tools > Internet Options.
The Internet Options dialog box opens.
3. Click the Security tab.

4. Click the Trusted sites icon.

22
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8.

9.

Click Sites.

Click Add.

0. Click OK.

Clear the Require server verification check box.

Enter the IP address of the poller.

Repeat steps 7 and 8 for each poller.

ABOUT NETVOYANT ADMINISTRATION

Most NetVoyant administrative tasks are performed in the NetVoyant Console. Only user accounts

with the Administrator role can make configuration changes in the NetVoyant Console. An

administrator typically performs the following tasks:

Task

Description

Page

Configure NetVoyant

Manage devices and networks

Manage MIBs

Manage events and alarms

Configure IP SLLA operations

Manage NetVoyant services

When you first start the NetVoyant Console, you must
configure how the NetVoyant product discovers and polls your
devices and networks. Use the Configuration Wizard to
streamline this process.

The NetVoyant product automatically adds the devices and
networks that it discovers to the groups shown on the Group
tab of the NetVoyant Console; however, you can manually add
devices and networks and implement custom groups to assist
with management and reporting,

The NetVoyant product uses SNMP Management Information
Bases (MIBs) to define the types of data it can collect from your
devices and how it collects that data. You can view these MIBs
to assist in creating event notifications or other administrative
tasks or you can compile new MIBs to add functionality to the
NetVoyant product.

The NetVoyant product uses events and alarms to alert you to
issues with NetVoyant Services as well as missed SNMP polls,
exceeded utilization, or other configurable thresholds on critical
devices. As an administrator, you can set thresholds, create
notifications that are triggered in response to events, and view
event and alarm logs.

In the NetVoyant Console, you can use the IP SLA Wizard to
configure Cisco IP SLA operations for devices that support
them. These operations provide data for IP SLA reports in the

NetVoyant reporting tool and the NetQoS Performance Center.

As an administrator, you can manage the processes generated by
the NetVoyant product to assist with troubleshooting, You can
also configure the alarm logging level for NetVoyant Services.

31

115

177

189

255

279
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Task Description Page
Administer reporting and In the NetVoyant web reporting tool, you can configure access 287
user accounts to the collected and stored data displayed in NetVoyant reports.

You can also control access to specific reports and create
custom views for NetVoyant data.

Using the NetVoyant Console

The NetVoyant Console is the central administrative interface for the NetVoyant product. Within the
NetVoyant Console, you configure how NetVoyant discovers, polls, and groups your SNMP-enabled
devices and networks. In the NetVoyant Console, you can also configure what type of data NetVoyant
gathers and how that data is stored in datasets.

To open and log into the NetVoyant Console:
I. From the Start menu, select All Programs > NetVoyant > NetVoyant Console.
2. Enter the username (user account) and password.

When you first set up your NetVoyant system, you can log in to the NetVoyant Console with the
default login:

username: nvadmin

password: nv

Net\l'oyant Console Login !E[ E

Net

Performance First
Copyright (z) 1999-2009 by MetQoS, Inc.

Uzername: Invadmin
Pazsword: I

Ok | Cancel | Clear | Help |

The NetVoyant Console Interface

On the left side of the NetVoyant Console is a tabbed panel called the tree-tab panel. On the right
side is a panel called the context panel. Selecting tabs and items in the tree-structures on the tree-tab
panel changes the information that appears in the context panel. For example, when you select a
device on the Group tab in the tree-tab panel, the context panel displays information about the
selected device.
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[EANetvoyant Console M=l E3
File Edit Wiew Logs Took Help
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q
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ShiMP Yersion

SNMP Titmeout:

vin-test-Nyvpoller -long not available
vm-tes-poll2 not availsble

]
SMMP Retries:
SMMP Discovery:

Polling Enabled:

Set Profils:
4

|»

IdEvID81 a

devicel0
Cisco Systems WE-C6509.Cisco Catalyst Operating System Software, Version 5
1361419544

Routers

Cizco3840

10.8.0.254

1060254

53pollers

(ShMPy2C &

5

d

" Extended (' Enabled { Disabled

. of

Group

Config | MIEs I Services

DatesTime: Severity De=scription I Source Errar coce Server I
st Mow 24 00:08:14 CST 2007 Wiarming Unable to overwrite manually specified itfSpeed for wansuite test box - Topology 0 win-test-Mvp.. &«
at Now 24 00:07.03 CST 2007 Warning Unable to overvwrite manuslly specified itSpeed for npic34214 - HP ETH... Topology 0 wrntest-NVR...
at Mow 24 00:06:47 CST 2007 Wiarning Unable to overwrite manuslly specified ifSpeed for stisys - M3 TCP Lo... Topology 0 wm-test-hvp... =
LOg Panels g0 20008 oEx o0 [T a— | lnable tn Auanarite man el snanifiard $naad foe nans M TOD L nn Temelnes 01 s bt mu,_’d
>
Ack | DatedTime I Type Source | Severity I Description Category I Error code Server I a
™ Gathov24 00:00:07 C5.. Threshold  vm-dsa22 - System |.. ¥Waming Threshold exceeded f.. Threshold O ym-tes-poll2 «
[T SatMov24 00:00:06 CS.. Threshold  wm-ra2 - Systern Idle .. Warning Threshald exceeded f.. Threshold O wn-tes-poll2
™ FriMov2313:55.00 GS.. Threshold garouter-2621-4.gal.. Minor Threshold exceeded f.. Threshold 0 vm-tes-poll2
I Fribov2313:4500 CS.. Threshold  garouter-2621-4.ga.l.. Minor  Threshold exceededf.. Threshold 0 wn-tes-poll2
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The Tree-Tab Panel

The tree-tab panel on the left-hand side of the NetVoyant Console is divided into four tabs:

Tab Description Page

Group Use this tab to view and configure your networks and devices, which are 118
organized according to default and customized groups.

Config Use this tab to perform configuration tasks such as determining how the 32
NetVoyant product discovers and polls your devices and networks. You can
also set thresholds and notifications for your devices.

MiBs Use this tab to view the Management Information Bases (MIBs) compiled 177
into the NetVoyant product. These MIBs determine the type of data that
can be collected.

Services Use this tab to stop, start, and change the logging level for NetVoyant 279

Services, which are the processes that make up the NetVoyant product.
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The Log Panels

You can choose to display the Event and Alarm Log panels at the bottom of the NetVoyant Console.
These panels display current event and alarm logs as triggered by service logging, missed polls, and
database notifications of threshold events. For more information, see “Working with Event and
Alarm Logs” on page 209.

You can also view the Discovery Log window, which displays logs related to the discovery process.
For more information, see “Configuring Discovery” on page 49.

The Context Panel

You can customize the tabs that are shown in the context panel for an object in the NetVoyant
Console. By displaying hidden tabs, you can view more information about the selected object. By
hiding tabs, you can restrict the tabs displayed in the context panel to only those that you need to

aCcCess.

To display, hide, or reorder tabs in the context panel:
I. Select the object in the tree-tab panel to view the object’s details in the context panel.

For example, to set the properties for a router, expand the poller, expand Devices > Routers, and
select the router.

2. Click the Customize tab in the context panel.
3. You can perform the following actions:

= To display a hidden tab, select the Show/Hide check box for the Tab Panel Title.
e To hide a tab, clear the Show/Hide check box for the Tab Panel Title.
= To change the order of the displayed tabs, select a tab panel title and click Raise or Lower.

Note: You cannot hide the Customize tab.

Configuring NetVoyant Console Properties

You can configure proxy server properties for the NetVoyant Console, such as the proxy server for
the NetVoyant Console to access HTML pages. This is an optional configuration setting.

To configure the NetVoyant Console options:

I. From the File menu in the NetVoyant Console, select Properties.

The Properties dialog box opens.

Proxy Server Configuration

[~ Enable proxy configuration

Proxy HosthamedP Address: I

Proxy Port Mumber: ISD

Ok I Cancel | Help |
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2. Edit the following parameters:

Parameter Description
Enable proxy configuration Select this check box to enable NetVoyant to access HTML files
through a proxy server.
Proxy Hostname/IP Address The hostname or IP address of the proxy server.
Proxy Port Number The port number of the proxy server.
3. Click OK.

Opening Reports from the NetVoyant Console

You can access NetVoyant reports for a selected group, device, poll instance, or interface directly
from the NetVoyant Console. You can also open the NetVoyant reporting tool from the NetVoyant
Console to view all NetVoyant reports, or open the NetQoS Performance Center from the
NetVoyant Console to view cross-product reports.

To open the NetVoyant reporting tool from the NetVoyant Console:
» From the Tools menu, select NetVoyant Reporting.

Note: For more information about viewing reports in the NetVoyant reporting tool, see the
NetVoyant User Guide.

If your NetVoyant system is registered as a data source with the NetQoS Performance Center, you
can view NetVoyant data as well as data from the other NetQoS data source products in the NetQoS
Performance Center web interface.

To open the NetQoS Performance Center from the NetVoyant Console:

» From the Tools menu, select NetQoS Performance Center.

Viewing the Reports Available for an Object in the NetVoyant Console

In the NetVoyant Console you can view a list of the NetVoyant reports that are currently available for
a selected device. Use this information to determine which reports will be affected if you disable
polling for a device or make other changes to the device’s configuration in the NetVoyant Console.

To view the reports available for a selected object:
I. On the Groups tab, expand the tree structure to locate the object.
2. Select the object.
The object’s details appear in the context panel.
3. Click the Reports tab.
This tab displays a list of NetVoyant reports available for the selected object.

Note: If the Reports tab does not appear in the context panel, click the Customize tab and select
the Reports tab for display.

4. If you want to launch the reporting tool and view the report using the selected object as the
context, select a report in the list and click Display.

NetVoyant 7.0 Administrator Guide 27



NetVoyant System Setup

The NetVoyant reporting tool displays the selected report in a browser window.

Note: For groups, you can open additional reports from the NetVoyant Console according to type.
To view these reports, click the tabs that correspond to the report menus in the NetVoyant reporting
tool. Select a report to see the report page for the selected group.

Scheduling Command Line Tasks from the NetVoyant Console

The NetVoyant product includes a scheduling feature so that various tasks can be performed on a
repeated basis, at specific times of the day and on a particular day of the week or month. It can also
support daily tasks.

Note: Tasks that are required for NetVoyant system functioning are locked by default and cannot be
modified.
To add or change a scheduled task:

I. On the Config tab, select the Schedules object.

The scheduled tasks appear in the context panel.

4
2] D-LIR-NY-1 (Master Cansale] M Pollingl Notific:ationsl Dizcovery Schedules | Trapsl
Mofifications 0 | Locked | TmeofDay | Dayotweek | Day of Month .
1] es 01:00:00 All 1 cmd IC mysglallstats bat 1=%ETATSHON o
1 Yes 00:00:00 Al Al emd JC "% STATSHOME%/hinfdbmaintain
2 Yes 02:00:00 Al Al emd JC "% STATSHOME %/hinfbaselines :
E gjj;:ig E;Z:ﬁ: EE::::; 3 Yes 05:00:00 Al Al emd IC "%STATSHOME %/hinfperiodic.ba
R 4 Mo 02:00:00 Al Al emd JC "% STATSHOME %/portalNPCSyn

-
1| | 3

Add Change Remove | Help |

Group  Config | MlBSI Servicesl

2. Do one of the following:

e To add a new task, click Add.
= To change a task definition, select the task in the list and click Change.

The Schedule dialog box opens.

Schedule [ %]
Enablect v

Day of Week: IAII vl Day of Marth: |A" :l'
Titne of Day:  HH:Mb |00: 0032

Commanc:

crnd AZ Vipconfig fushdns"

Ok I Cancel | Help |
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3. Set the parameters to define the scheduled task:

Parameter Description

Enabled Select this check box to enable the task so that it is executed according to its
schedule.

Day of Week Use this setting to specify a day for a weekly task. Leave the default (All) if all

days of the week are valid.
When both Day of the Week and Day of the Month are set to All, it
specifies a daily task.

Day of Month Use this setting to specify a date of the month for a monthly task. Leave the
default (All) if all dates in the month ate valid.

Time of Day Use this setting to specify a time of day to execute the command line task.
This setting uses a HH:MM format. Click the HH in the field and use the
arrow buttons to adjust the specified hour up or down. Do the same for the

minutes (MM).

Command In this field, enter the command that will be executed.

4. Click OK.

Installing a Remote NetVoyant Console

A remote NetVoyant Console can be installed on a standard desktop or laptop. This utility enables
you to remotely configure the NetVoyant system without using a terminal session to gain access to
the NetVoyant Console on the main server. There are no additional licenses required to use the
remote NetVoyant Console application.

The installer for the NetVoyant Console is located with your NetVoyant server as:
d:/NetVoyant/netvoyant-console-x._x.x-win32-i586. .exe

where d: is the drive on which NetVoyant is installed and x.X.X is the version number of the
NetVoyant Console Installer.

To install the remote NetVoyant Console:

I. Copy the installer (the full executable) to the target workstation or laptop.

2. On the workstation or laptop, double-click the installer to start the installation process.
You should see cab files being expanded and then an Install Shield window.

3. Step through the process using the Next> button.

4. Atthe DNS hostname or IP address prompt, enter the fully qualified DNS name or the IP address
of the NetVoyant Master or standalone server.

When the main NetVoyant server is upgraded, you should also update Console-only desktops or
laptops with the installation kit copied to the main server during the upgrade.
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Maintaining the NetVoyant Database

You should perform a backup of the NetVoyant database on a monthly basis. All of the NetVoyant
data is stored under the Dz \NetVoyant\db\nms2 directory.

Important: It is strongly recommended that you stop the web server and the NetVoyant services
when backing up or restoring the database to ensure data consistency. For more information about
stopping NetVoyant services, see “Starting or Stopping All Services” on page 282.

NetQoS Database Tools Suite

The NetQoS Technical Support team distributes and maintains the NetQoS Database Tools Suite on
the NetQoS Self Service Portal. The NetQoS Database Tools Suite contains a bundle of small,
efficient, and feature-rich tools that interact with the MySQL databases on most NetQoS products.
These tools have been developed to ease the administration overhead of database backups,
optimization, and repairs, as well as provide a way to restore an existing backup. It also includes a user
administration tool for creating MySQL user accounts with SELECT-only rights for accessing/
exporting data.

To download and install the NetQoS Database Tools Suite, log into the NetQoS Self Service Portal,
navigate to the Support > Support Tools page, and click the NetQoS Database Tools Suite link.
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CHAPTER 2

Configuring Your
NetVoyant System

The NetVoyant product includes a number of flexible configuration options that you can use to
determine how it discovers and polls your devices and networks. You can also configure how the

NetVoyant database stores related data and the display of data in NetVoyant reports. When you first

start the NetVoyant Console, use the Configuration Wizard to streamline the initial configuration

process.

Note: You can return to the Configuration Wizard or access the Config tab in the NetVoyant Console
to update configuration options at any time.

This chapter covers the following topics:

“NetVoyant Configuration Tasks” on page 32

“Using the Configuration Wizard” on page 33
“Performing Initial Configuration Tasks” on page 34
“Configuring Discovery” on page 49

“Configuring Device Classes and Models” on page 59
“Troubleshooting NetVoyant Configuration” on page 65
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NETVOYANT CONFIGURATION TASKS

Before the NetVoyant system identifies the devices on your network, collects data for those devices,
and provides reports on the data, you must complete some initial configuration tasks. Additional
configuration is required only to ensure that the data you need is collected and displayed in reports
according to your organizational needs.

Configuring the NetVoyant product includes the following types of tasks:

Required? Configuration task More information

Yes Configure discovery. “Configuring Discovery” on
Define what NetVoyant discovers by configuring NetVoyant P8¢ 49

discovery.

Note: The initial tasks that you perform in the
Configuration Wizard quickly configure the NetVoyant
discovery process. For more information, see “Using the
Configuration Wizard” on page 33

No Configure data collection and retention. “Viewing and Configuring
Data by Poll Instance” on
page 69

Configure overall data collection and retention by configuring
datasets.

If you do not complete this task type, the NetVoyant system
collects data based on default settings and the information
from the discovered devices.

No Configure and manage polling. “Configuring Data

Contfigure the polling frequency for a device by managing Collection Frequency” on
polling, page 94

If you do not complete this task type, the NetVoyant system

collects data based on default datasets and the information

from the discovered devices.

No Configure user roles. “Adding and Editing Roles”

Control how users are able to use the NetVoyant reporting on page 296

tool and interact with your networks and devices by adding
and configuring NetVoyant user roles (performed in the
NetVoyant reporting tool or the NetQoS Performance
Center).

If you do not complete this task type, the NetVoyant system
provides access to administration and report data using the
default roles and settings.

No Configure user accounts. “Adding or Editing a

Manage access to the NetVoyant Console and collected data NetVoyant User” on
by creating and configuring NetVoyant user accounts page 299
(petformed in the NetVoyant reporting tool ot the NetQoS

Performance Center).

If you do not complete this task type, the NetVoyant system
provides access to administration and report data using the
default user accounts and settings.
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USING THE CONFIGURATION WIZARD

The first time you open the NetVoyant Console in a standalone system, the Configuration Wizard
opens. Use this wizard to set up the initial configuration for the NetVoyant product and discover the

devices on your network. It continues to open by default until you have configured discovery scopes
and SNMP profiles.

Note: The Configuration Wizard does not display the first time that you open the NetVoyant Console
on a distributed system. However, it is the most straightforward method for performing the initial
configuration on a distributed system from the Master console. For more information about
differences between standalone and distributed systems, see “NetVoyant Architectural Overview and
Licensing” on page 16.

To use the Configuration Wizard to configure the NetVoyant product:

I. From the Tools menu in the NetVoyant Console, select Configuration Wizard.

= Click Next to step through the wizard.
= Click Back to step backwards to a previous step.

[l Configuration Wizard for nv608fresh M= E3
A ~Configuration Wizard for nvE03fresh
About the i
Configuration Wizard R - - -
g Using the Configuration Wizard
The firsttime you open the
Metvovant Consale for a When you first start the Metvoyant console, the Configuration Wizard appears. Use
standalone configuration, the the Configuration Wizard to discover the devices on your network and setup initial
Configuration Wizard opens. canfiguration in Metvoyant.
Use this wizard to set up the
initial configuration for the Far mare infarmation on how to use the Configuration Wizard see the Netvoyant
Metvoyant product and Help, availahle fram the Help menu.
discover the devices on yaur
network.
= Back | Mext = Close |

2. Add the SNMP profiles.
For more information, see “Adding SNMP Profiles to the Console” on page 34.
3. Add discovery scopes.
For more information, see “Configuring the Discovery Scopes” on page 40.
4. (Optional) Add discovery seeds.
For more information, see “Adding Discovery Seeds” on page 43.
5. Select polled device classes.
For more information, see “Enabling or Disabling Polling for a Device Class” on page 45.
6. Start discovery.
For more information, see “Initiating Discovery” on page 46.

7. On the last screen of the wizard, click Finish.
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PERFORMING INITIAL CONFIGURATION TASKS

You can use the Configuration Wizard to perform the tasks described in this section. These tasks
enable you to complete a preliminary configuration of your NetVoyant system and initiate the
discovery of your network.

Adding SNMP Profiles to the Console

The NetVoyant Console uses SNMP profiles in order to establish access to the devices on your
network. In defining a profile, you create an identity used for authentication when performing SNMP
queries and sets. The NetVoyant Console supports authentication to devices using SNMPv1,
SNMPv2, and SNMPv3.

Note: If you are running a distributed NetVoyant system, you must add or modify SNMP profiles on
the Master server. If a poller is not operational when the configuration change occurs on the Master,
the change will be synchronized when communication with the poller is restored.

Configuring the SNMP Profile List

You can configure these profiles directly in the Configuration Wizard or you can access and edit
SNMP Profiles from the Config tab in the NetVoyant Console. The NetVoyant product requires at
least one valid SNMP profile for each device in order to retrieve polling data.

To add an SNMP profile in the Configuration Wizard:

I. From the Tools menu in the NetVoyant Console, select Configuration Wizard.

2. Click Next once to display the SNMP Profiles list.

ShihP Profiles

Profile Matne | SMMP Yersion Security Level
public SHNMPy1/SHMPY2C Mo-Authentication, Mo-Priv..
netgos SHNMPy1SMMPY2C Mo-Authentication, Mo-Priv...
redpt SHNMPy1SMMPY2C Mo-Authentication, Mo-Priv...
redpaint SHNMPy1SMMPY2C Mo-Authentication, Mo-Priv...
ngSecure SHMPY3 Mo-Authentication, Mo-Priv...

Remove Chanoe | Raise | Lawver | Help |

3. Click Add.
4. In the SNMP Profiles dialog box, enter the parameters for the new SNMP profile and click OK.

For information about setting parameters for SNMP Profiles, see “Defining SNMP Profiles” on
page 35.

5. To change the position of a profile in the list, select it and click Raise or Lower.
Note: When discovering a device, the NetVoyant product checks each profile in list order to

identify a valid profile for that device. Re-ordering the SNMP profiles to make the most-used
profiles highest in the list can significantly reduce the amount of time required for discovery.
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6. Click Next to continue through the rest of the Configuration Wizard.

7. On the last page of the wizard, click Finish.

To add an SNMP profile from the Config tab:

I. In the NetVoyant Console (Master or standalone), click the Config tab.
2. Expand the Master server.

3. Expand Discovery and select SNMP Profiles.

The currently configured profiles appear in the context panel.

rp23|1|.andup (Master Consols) : Discovery Scopes I Discovery Seeds I Device Models I Device Classes I Interface Types  SNMP Profiles |
Ol
A Notifigations Profile Mame | SMMP Yersion | Security Level |
E‘g Discovery public SHNMPy1/SHMPY2C Mo-Authentication, Mo-Privacy
Discovery Scopes netgos SHNMPy1SMMPY2C Mo-Authentication, Mo-Privacy
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4. Click Add.

The SNMP Profiles dialog box opens.
5. In the dialog box, enter the parameters for the new user profile and click OK.

For information about setting parameters for SNMP Profiles, see the following section.
6. To change the position of the profile in the list, select it and click Raise or Lower.

Note: When discovering a device, the NetVoyant product checks each profile in list order to
identify a valid profile for that device. Re-ordering the SNMP profiles to make the most-used
profiles highest in the list can significantly reduce the amount of time required for discovery.

Defining SNMP Profiles

Establishing access to the devices on your network from the NetVoyant Console depends upon
creating profiles that it can use for authentication. NetVoyant supports authentication to devices
using SNMPv1, SNMPv2C, and SNMPv3. You can define multiple SNMP profiles in the NetVoyant
Console so that you can accommodate multiple types of protocols and access credentials used across
your network.

SNMPvI and SNMPv2

For SNMPv1 or SNMPv2C, authentication consists of providing the correct community string for a
particular access level (get and set). If a device is assigned an SNMP profile with the correct
community strings, access is granted.
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If you plan to configure IP SLLA operations for a device directly from the NetVoyant Console via
SNMPv1 or SNMPv2C, you must create a profile to define both the read and write community
strings (the get and set community strings) for the device. For more information, see “Setting SNMP
Profiles for a Device” on page 149.

SNMPv3

Establishing contact using SNMPv3 is more complex. SNMPv3 employs a User-based Security Model
(USM). Before access is granted at a particular level, a security user (in this case, the NetVoyant
Console) and a set of authentication and privacy keys must be verified by the device’s SNMP engine.
This set of authentication and privacy keys (called a ¢redential) is linked to an SNMP profile that the
NetVoyant Console uses when contacting a device.

For more information about specifying SNMPv3 authentication and privacy, see “Using SNMPv3
Security Credentials” on page 37.

To create or edit an SNMP Profile:
I. Open the SNMP Profiles dialog box.
= From the Config tab, expand Discovery, sclect SNMP Profiles, and click Add or Change in the
context panel.
= From the Configuration Wizard, click Next once to display the SNMP Profiles list and click Add
or Change.

2. In the Profile Name ficld, enter a unique name for the profile.

Note: Profile names must be unique and are not case-sensitive (for example, “Public” and
“public” are considered the same and not unique). The NetVoyant Console does a validity check
when you save the settings.

3. Select or clear the Enabled for Discovery check box.
= If the profile is enabled (the default setting), NetVoyant tests the profile during discovery and
assigns it based on a successful match.

= If the profile is not enabled for discovery, NetVoyant does not test the profile during discovery
when it attempts to determine a device’s SNMP version/profile. When the profile has
previously been assigned to a device and you disable the profile, NetVoyant attempts to assign
another profile during the next discovery cycle.

4. Choose the SNMP Version for the profile.

Profiles can be configured for SNMPv1, SNMPv2c, or SNMPv3. When either SNMPv1 or
SNMPv2c is selected, you specify the community string that is used to gain access. When SNMPv3
is selected, you use the bottom portion of the dialog box to configure access levels using
authentication and privacy protocols.

Note: You cannot change the SNMP version for a profile after it has been created.
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5. Enter the port number in the Port field.

The default port for SNMP is port 161; however, if you are using another port for SNMP polling,

specify that port number for the profile.

6. Enter the community/security information.

If either SNMPv1 or SNMPv2c is selected as the SNMP version, enter the community string in

the Community field and again in the Verify ficld.

Note: Each SNMPv1/v2 profile must use a unique community string. If you attempt to create a
profile with a community string used by an existing profile, the NetVoyant Console will not accept

the profile.

If SNMPvV3 is selected as the SNMP version, see the following section for more information about

configuring SNMPv3 security protocols.
7. Click OK.

Using SNMPv3 Security Credentials

SNMP Version 3 (SNMPv3) is an interoperable standards-based protocol for network management.
SNMPv3 provides secure access to devices using a combination of authenticating and encrypting

frames over the network.

SNMPv3 provides for both security models and security levels. A security model is an authentication
strategy that is set up for a user and the role in which the user resides. A security level is the permitted
level of security within a security model. A combination of a security model and a security level
determines which security mechanism is employed when handling an SNMP packet.

= Authentication - utilizes time-stamping and password hashing to reduce the chance of
unauthorized access of an SNMP-enabled device from a Network Management Station (NMS).

= Privacy - provides encryption for SNMP messages sent across a network, ensuring message
integrity and preventing intercepted SNMP packets from being deciphered by unauthorized users.

This can be used only with authentication.
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To a define an SNMP Profile using SNMPv3:
I. Open the SNMP Profiles dialog box.

= From the Config tab, expand Discovery, select SNMP Profiles, and click Add or Change in the
context panel.

e From the Configuration Wizard, click Next once to display the SNMP Profiles list and click Add
or Change.

2. In the Profile Name ficld, enter a unique name for the profile.

Note: Profile names must be unique and are not case-sensitive (for example, “Public” and

“public” are considered the same and not unique). The NetVoyant Console performs a validity
check when you save the profile settings.

Profile Matne InqSecure Enahled for Discovery v
ShiP Yersion ISNMPVS LI Part |1 &1
User Mame FEEREELES
ShMPY3
Context Mame Isecur'rty
Security Level IAuthentic:ation, Privacy LI
Authentication Privacy
Auth Protocel  [SHA x| || PrivProtocol  [DESSE =
Auth Password I****** Priv Password I*******
Verify Iﬂ‘ﬂ‘ﬂ‘ﬂ‘ﬂ‘ﬂ‘ Verlfy Iﬂ‘ﬂ‘ﬂ‘tﬁﬁﬁ
Cancel | Help |

3. Select or clear the Enabled for Discovery check box.

= If the profile is enabled (the default setting), NetVoyant tests the profile during discovery and
assigns it based on a successful match.

= If the profile is not enabled for discovery, NetVoyant does not test the profile during discovery
when it attempts to determine a device’s SNMP version/profile. When the profile has

previously been assigned to a device and you disable the profile, NetVoyant attempts to assign
another profile during the next discovery cycle.

4. Choose SNMPv3 as the SNMP Version for the profile.

5. Enter the port number in the Port field.

The default port for SNMP is port 161; however, if you are using another port for SNMP polling,
specify that port number for the profile.
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6. Enter the remaining parameters in the dialog box to define the security and authentication.

Parameter

Description

User Name

Context Name

Security Level

Authentication

Privacy

This is the User Name used for device access.

Note: Each SNMPv3 profile must use a unique user name. If you attempt to
create a profile using the same user name as an existing profile, the NetVoyant
Console will not accept the profile.

(Optional) For devices that support both switch and router interfaces, use this
setting to specify a keyword that applies to the particular context where this
profile will be applied.

Note: You must create separate profiles for each context when a device
supports both router and switch contexts.

This specifies the secutity level to be used. The two security areas are grouped
together into a security level, allowing for three possible Security Levels:

* No Authentication, No Privacy
* Authentication, No Privacy

® Authentication, Privacy

If the selected security level applies authentication, select the authentication
type (MD5 or SHA) from the drop-down list and enter the password
(between 1 and 64 characters in length) used to determine Authentication and
verify it.

If you make a change to an existing password and the credential is currently
used with a profile that is applied to one or more devices, a confirmation
dialog box opens.

If the selected security level applies privacy, select DES56, AES128, or 3DES
from this drop-down list and enter a password (between 1 and 64 characters
in length) used to determine Privacy and verify it.

If you make a change to an existing password and the credential is currently
used with a profile that is applied to one or more devices, a confirmation
dialog box opens.

7. Click OK.

SNMP Profiles in the NetQoS Performance Center

When your installation of the NetVoyant product is bound to the NetQoS Performance Center, the
SNMP profiles defined in the NetVoyant Console are automatically added to NetQoS Performance
Center. These profiles are also distributed to any other NetQoS products that are bound to that

NetQoS Performance Center during the next synchronization cycle.

The NetQoS Performance Center minimizes duplication of SNMP profiles by comparing the User
(SNMP v3) or Community String (SNMP v1 and v2) values to existing profiles when a new data

source is added. If a profile already exists with the same User or Community String, the profile with

the most recent change (based on the timestamp) is used as the master profile.

During synchronization, if the NetQos Performance Center encounters a new profile name that

matches an existing profile, but the User or Community String values do not match, it saves the newer

profile by appending a number to the duplicate name so that it is unique. For example, the first profile
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named “Boston” retains this name, and “Boston(1)” is used as a unique name for the second profile.
When the NetQos Performance Center changes the profile name during this synchronization process,
the name change is also implemented in the data source product during the next synchronization.

SHMP Profile List
. . R . Used During
Order Profile Hame SHMP Version Authentication Privacy n
Discovery

O public SHMPw1/SNMPVZC None None es
(O]

O 3 redpt SHMPw1/SNMPVZC None None es
O 4 redpoint SHMPw1/SNMPv2ZC None None Yes

[ Mowve Up ] [I.m\.fe Duwn] [ New ] [ Edit ] [ Delete ]

If you or another administrator add or modify an SNMP profile in the NetQoS Performance Center,
these changes are synchronized with all of the registered data source products, including the
NetVoyant product.

Configuring the Discovery Scopes

When you specify discovery scopes, the NetVoyant product discovers only networks and devices
included in your discovery scope list. It can detect all networks and devices connected to your system,
but you should designate the items to include and exclude from the discovery process. It is highly
recommended that you add discovery scopes to limit the number of devices discovered, especially
when connected to large networks, such as the Internet.

Note: If you are running a distributed NetVoyant system, it is recommended that you configure
discovery scopes on the Master server and specify the appropriate poller for each scope. If a poller is
not operational when the configuration change is made on the Master, the change will be
synchronized when communication with the poller is restored.

You can add, edit, and remove items in the Discovery Scopes list using the Configuration Wizard, or
from the Config tab in the NetVoyant Console. You can also import a list of items using a standard
text file.

Adding Networks and Devices to the Discovery Scopes

By default, the Discovery Scopes list is empty when the NetVoyant product is first installed. If the
discovery process is enabled and executed without any scoping parameters, the NetVoyant product
will attempt to discover all networks that are connected to the NetVoyant system. This can produce
undesired results.

To ensure that the NetVoyant product discovers only those networks and devices that you want, add
items to the Discovery Scopes list to be explicitly included or excluded during discovery.

Note: It is possible to explicitly exclude networks and devices. This may be necessary when you
specify a large network (such as a class B), but you want to exclude some of the smaller scopes (such
as class C networks). The inclusion and exclusion of certain networks and devices is controlled by the
Include check box in the Discovery Scopes list.

40
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To add a discovery scope:

I. Access the discovery scopes list in the NetVoyant Console in one of two ways:
= From the Tools menu in the NetVoyant Console, select Configuration Wizard and click Next
until the Discovery Scopes screen appeatrs.

e C(lick the Config tab and select Discovery > Discovery Scopes.
2. Click Add.

Note: If you need to import a scope file instead of entering the scope information, click Import.
For more information, see “Importing Discovery Scopes” on page 42.

3. Specify the discovery scope:
e To add a network, select Network and enter the Network IP Address and Network Mask.

e To add an individual device, select Device, enter the Device Name or IP Address.
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192168123, 255.255.255.255 v nvB0Epoller

Netvoyant only discovers 192168123, 255.255.255.255 v nvB0Epoller
networks and devices that 182.168.0.102 255.255.255.255 V nvB0GRoller
A o coveryscope [
discovery scope list Itc (@) & peyice  Network poller
detect all networks and paller

i oller
gﬁrlycoeusnoene‘;otuor;:g};m DERiee MEmEAP AEEEes I1 no40157 Eoller
which items to include : poller
exclude from the discov Device Mask: I255.255.255.255 poller
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recommend that you ac Poller: InVBUBDDIIEF i | poller
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Internet. R LI
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click Import. For more LI
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4. Designate the scope as included or excluded:
= To include the network or device in discovery, select the Include in Discovery check box.

* To exclude the network or device from discovery, clear the Include in Discovery check box.
5. For a distributed system, use the Poller drop-down list to designate a poller.

This setting determines which poller “owns” the scoped item because pollers are typically
partitioned by network scopes. For a standalone system, this is automatically set to the local poller
(Master) and cannot be changed.

6. Click OK.

7. If you add or edit discovery scopes in the list using the Configuration Wizard, click Next to
continue to the last page of the wizard and then click Finish.
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Importing Discovery Scopes

You can import a text file that contains your discovery scopes to simplify this process. The file must
contain a list of devices and networks that you want to include in your discovery scope. Each device
or network IP address must be on a separate line in the file.

The following is an example of a valid list of discovery scope entries:

192.168.123.1
192.168.123.2,255.255.255.255
192.168.123.3/32
192.168.123.0/24
192.168.124.0,255.255.255.0

Note: If you are using a distributed NetVoyant system, you must specify a single poller for the
imported discovery scope list. If your list contains items for different pollers, you can create separate
text files and import each with an assignment to the correct poller. Or, you can import the scopes
designating a single poller and then use the Change button to re-assign items to the correct poller.

To import a list of discovery scopes:
I. In the NetVoyant Console, click the Config tab.
2. Expand Discovery.
This provides access to discovery configuration.
3. Select Discovery Scopes.
The currently configured discovery scopes appear in the context panel.
4. Click Import.

If you are running a distributed NetVoyant system and are importing the scope on the Master, the
Select Poller dialog box opens.

Select Poller [ %]

‘hich Metvoyant system would you like o import bo?
|x84r2standupv2 LI

Cancel |

5. (Distributed only) Use the drop-down menu to select a poller and click OK.
The Select Scope File dialog box opens.

6. Browse for and select the text file that contains the discovery scopes.
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8. Confirm the import by choosing to append or replace the existing discovery scopes list.
= Click Append/Merge to add the discovery scopes in the imported file to the current discovery
scopes. The NetVoyant product scans the imported file for valid scopes, ignores duplicate
entries, and displays the number of valid scopes that it finds.
= Click Replace to remove the current discovery scopes and add the discovery scopes in the
imported file. The NetVoyant product scans the imported file for valid scopes and displays the
number of valid scopes that it finds.

9. Click OK.

Adding Discovery Seeds

The NetVoyant product uses discovery seeds to provide starting points for the discovery process.
Seeds are specific devices or networks that it probes during the discovery process to find other
devices and networks to discover.

Adding discovery seeds is not required; however, in some situations it can be useful to provide these
“hints.” For example, when you want the NetVoyant product to discover networks that are separated
from the poller by a public network or when it cannot discover a gateway router because of problems
with its access list or SNMP profiles.

If you add a device as a discovery seed, the discovery process will first PING, then scan the device
and start discovery at that point. If you add a network as a discovery seed, a broadcast Ping will be
sent to that subnet and all devices that respond will be discovered.

Note: If you are running a distributed NetVoyant system, it is recommended that you configure
discovery seeds on the Master and specify the appropriate poller for each seed. If a poller is not
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operational when the configuration change is made on the Master, the change will be synchronized
when communication with the poller is restored.

To add a discovery seed:
I. Access the discovery seeds list in the NetVoyant Console in one of two ways:

= From the Tools menu in the NetVoyant Console, select Configuration Wizard and click Next
until the Discovery Seeds List screen appears.

* (lick the Config tab and select Discovery > Discovery Seeds.
2. Click Add.
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3. In the Discovery Seed dialog box, specify a seed.

= To add a network as a discovery seed, select Network and enter the network IP address and
network mask.

e To add an individual device as a discovery seed, select Device and enter the device name or IP
address.

4. For a distributed system, use the Poller drop-down list to designate a poller.

This setting determines which poller “owns” the seed item. For a standalone system, this is
automatically set to the local poller (Master) and cannot be changed.

5. Select or clear the Extended Discovery check box to include or omit the seed in extended
discovery.

When this option is selected, the NetVoyant product rediscovers the device’s characteristics during
its rediscovery process. It also uses information in the ARP cache and IP routing table for this
device to discover other devices. For more information about extended discovery, see “The
NetVoyant Discovery Process” on page 49.

6. Click OK.

7. If you add or edit discovery seeds in the list using the Configuration Wizard, click Next to
continue to the last page of the wizard and then click Finish.
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Enabling or Disabling Polling for a Device Class

To control the types of devices from which a NetVoyant poller collects data, you can select which
device classes are automatically enabled for polling upon discovery.

The NetVoyant product discovers all devices within your discovery scope; however, it does not
automatically enable polling for those device classes that are excluded from polling. If it discovers a
new device and its class is not enabled for polling, it does not gather any data from the new device
unless you enable polling for it after discovery.

In a distributed NetVoyant system, configuration of device classes must be done on the Master server.
If a poller is not operational when the configuration change is made on the Master, the change will be
synchronized when communication with the poller is restored.

Note: Enabling or disabling polling for a device class does not affect polling for devices that are
already discovered.

Important: It is strongly recommended that you do not remove device classes from the NetVoyant
Console. If you remove a device class, the NetVoyant Console defines all devices of this class as part
of the “Other”device class and continues to poll the devices. If you do not want to poll a particular
device class, disable that device class from polling,

To set polling for device classes:
I. Access the Device Classes list in the NetVoyant Console in one of two ways:

= From the Tools menu in the NetVoyant Console, select Configuration Wizard and click Next
until the Device Classes screen appears.

* C(lick the Config tab and select Discovery > Device Classes.
2. Enable or disable device classes.

= To turn off polling for a device class, select the device class and click Disable.

= To turn on polling for a device class that is disabled, select the device class and click Enable.
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3. If you modify automatic polling for device classes using the Configuration Wizard, click Next to
continue to the last page of the wizard and then click Finish.

Initiating Discovery

After you complete configuration using the Configuration Wizard, start the discovery process so that
the NetVoyant product can begin to discover your networks and devices. By default, it performs initial
discovery when triggered from the Configuration Wizard. From then on, it performs a partial
rediscovery every night at midnight (by default) to update device configuration information. You can
configure the time at which partial and full rediscovery takes place on the Config tab. For more
information, see “Configuring Discovery Options” on page 52.

You can also initiate a rediscovery of an individual device, group of devices, or your entire network
manually. For more information about manually rediscovering an individual device, see
“Rediscovering Devices and Groups” on page 152.

To start the initial discovery from the Configuration Wizard:
I. On the Tools menu in the NetVoyant Console, click Configuration Wizard.
2. Click Next until the Discovery Log screen appears.

For more information about setting the discovery options before proceeding with the initial
discovery, see “Configuring Discovery Options” on page 52.

3. Click Start Full Discovery.
NetVoyant adds a discovery log to the list for each new device or network that it discovers.

4. Click Discovery Monitor to verify that the NetVoyant product is discovering devices as expected.
For more information, see “Monitoring the Discovery Process” on page 47.

Note: For assistance with troubleshooting issues during the discovery process, see
“Troubleshooting NetVoyant Configuration” on page 65.

5. After discovery begins, click Next to review a summary of your configuration selections.

6. Click Finish.

To start a rediscovery of your entire network:

I. In the NetVoyant Console, click the Config tab.
2. Click Discovery.

46 NetVoyant 7.0 Administrator Guide



Configuring Your NetVoyant System

[EAnetvoyant Console 1]
File Edit Wew Logs Tools Help

|8+ mm|]7]

xBdr2standup (Master Conzale)
Polling
/Ty Notifications

Dizcovery Scopes
Dizcovery Seeds
Device Models
Device Classes
S8 Irterface Types
SHMP Profiles

ﬁ Schedules

L Traps

|8 xBar2standupy2 (Paller)

et na, e

4
W Poling | Motifications  Discovery | scheduies | Traps |

Periodic Discovery

Periodic discovery enabled: r

Mext Discovery Time: Thu Jan 21 00:00:00 CST 2010

Interyal Cffset: Days lJ

= L |
= L |

Thu Jan 21 00:00:00 CST 2010

P

Start Full Discovery |

Intersal: Days |1

Mext Full Discovery:

Full Discovery Interval:

Start Partial Discovery |

3. In the context panel,

Fap——— P ah

click one of the start discovery buttons

= To start a full discovery of your entire network, click Start Full Discovery.

= To start a partial discovery of your entire network, click Start Partial Discovery.

For more information about the differences between a full and partial discovery, see “Using Full
and Partial Discovery” on page 49.

Monitoring the Discovery Process

The Discovery Monitor can help you troubleshoot and monitor the discovery process as it is
occurring, It provides information about what the NetVoyant product is currently discovering and
when the next discovery process is scheduled to occur.
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It is recommended that you monitor the initial full discovery of your network using the Discovery

Monitor.

Note: For assistance troubleshooting issues during the discovery process, see “Iroubleshooting
NetVoyant Configuration” on page 65.

To view the Discovery Monitor:

» From the Tools menu in the NetVoyant Console, select Discovery Monitor.

The Discovery Monitor opens.

The Discovery Queue Size at the bottom of the Discovery Monitor indicates the number of
devices that are currently queued for discovery. The graphical breakdown by device class indicates
how many devices of each class are currently discovered.
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To force a stop of the discovery process:

I. In the NetVoyant Console, click the Services tab.
2. Select the Topology service.
3. Click Stop.

This stops the discovery process.

Note: For more information about the Topology service and other NetVoyant services, see
“Managing NetVoyant Services” on page 279.

Viewing the Discovery Log

In addition to the Discovery Monitor, you can use the discovery log window to monitor the discovery
process. This tool displays logs related to the discovery process. Any networks or devices that are
discovered are added to the list as a separate log item.

Discovery Log for #64rZstandup M= E3

Log Help

Timestamp |Discovery Message |Name |
ed Mar 17 11:34:48 CDT 20... Changed Routers e 10.0.8.199 -

Wed Mar17 11:34:59 CDT 2. Changed Routers § 10.0.9.193 j

Wed Mar 17 11:35:01 COT 2..  Changed Routers § 10.0.7.4

Wed Mar17 11:35:03 CDT 2., Changed Routers

e 10.0.40.67
Wied Mar17 11:35:04 CDT 2., Changed Other ¥

A 10.0.3.1
Wed Mar17 11:35:14 CDT 2., Changed Routers ¥ 10.0.40157
Wed Mar17 11:35:23 CDT 2. Changed Routers ¥ 10.0.40.1458
Wied Mar17 11:35:25 CDT 2., Changed Switches R 10.0.40.69

-
e Moy 47 442897 COT 9 Channad Cusitebne Fiannz49 _I

To view the discovery log window:

> From the Tools menu in the NetVoyant Console, sclect Discovery Log.

The discovery log window displays the following information:

Parameter Description

Timestamp The date and time at which NetVoyant discovered the network or device.
Discovery message A description of the type of discovery that was made.

Name The name of the network or device that NetVoyant discovered.
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CONFIGURING DISCOVERY

When the NetVoyant product discovers your network, it finds the SNMP-manageable devices in your
discovery scope. It also discovers which SNMP tables are supported by each discovered device.
NetVoyant discovery is based on SNMP and ICMP.

To enable the NetVoyant product to discover devices on your network and to control what it
discovers, you must configure the discovery process.

Note: You can perform all required steps to configure initial discovery in the Configuration Wizard.
For more information, see “Using the Configuration Wizard” on page 33.

The NetVoyant Discovery Process

The first discovery cycle that you initiate on the NetVoyant system is a full discovery. This first
discovery is required so that the NetVoyant product can identify the devices on your network and
determine what types of data it can collect from each device. After this initial discovery, you can make
numerous configuration customizations to fine-tune rediscovery, polling, and data collection.

Using Full and Partial Discovery

The NetVoyant product can execute two different types of discovery: full and partial. As a NetVoyant
administrator, you can determine how often the NetVoyant system does a partial discovery of known
devices and how often it completes a full rediscovery of all devices on your network.

Full Discovery. When the NetVoyant product performs a full discovery, it attempts to discover all
enabled datasets against each device. This is the required discovery process for initial discovery, and is
also desirable for less frequent or manual rediscovery in order to capture new devices and dataset
changes, such as which devices and datasets are enabled for or disabled from polling.

Partial Discovery. When the NetVoyant product performs a partial discovery, it attempts to
rediscover only those datasets that were previously discovered on each device. This means that only
new poll instances for an existing dataset on a known device will be discovered. Because most devices
do not change functionality regularly, a partial discovery is desirable for regular daily rediscovery of
your NetVoyant system. If you have a large number of devices, this can save a significant amount of
processing time.

For more information about the sequence of events when the NetVoyant system performs a full and
partial discovery, see the following section.
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Discovery Sequence of Events

By default, the NetVoyant product executes an automatic full rediscovery on a weekly basis. You can

change this setting in the Discovery Options to be more or less frequent, and you can manually

execute a full discovery at any time. For more information about setting the periodic rediscovery

options and manually executing a full or partial rediscovery process, see “Configuring Periodic

Discovery” on page 52.

The NetVoyant product completes the full discovery process in the following sequence of events:

Sends out a PING and queries with SNMP. By default, the NetVoyant product sends a ping to
each device within a discovery scope. You can use the broadcast ping option so that it captures a
wider range of connected devices and networks. From the responses, it sends queries to determine
the SNMP version supported by the responding device (if any) and the SNMP profile that will
work with the device.

Queues responding devices. It then runs events 3 through 5 for devices in the queue. The
NetVoyant product queues any additional devices that are discovered during these events.

Classifies devices based on a configurable database of device models and classes. Devices
that it recognizes as part of a known device class are added to the related NetVoyant group.

Polls devices with SNMP to discover poll instances. The NetVoyant product queries any
tables that are used by the default datasets for poll instances. Poll instances correspond to the
SNMP rows in these tables.

For example, it queries the FrCircuitEntry MIB table for poll instances in the pre-configured
Frame Relay Circuit Statistics dataset. You can add custom datasets and compile new MIBs into
the NetVoyant Console to extend what poll instances it discovers in this stage.

Queries the device’s ARP cache and IP routing table to discover further devices. The
NetVoyant product completes this stage only if a device is configured as a discovery seed or set to
extended discovery.

It queries the internal tables to look for additional devices on the LAN segment or adjacent LAN
segments. This information is also used to map IP addresses to MAC addresses for devices that
don’t respond to SNMP. This information is useful for RMON matrix reporting (the RMON data
is based on MAC address).

The NetVoyant product also queries the ipRouteEntry table (IP routing table) to find the “next
hop” networks. If these networks are in scope, it queries for discoverable devices.

Continues events 3 through 5 with each discovered device until the discovery queue is
empty.
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By default, the NetVoyant system also executes a partial rediscovery on a daily basis (midnight). This
partial discovery process is designed to rediscover only those datasets that were previously discovered
on each known device. You can modify the time of day and frequency of this automatic partial
rediscovery, or manually execute a partial rediscovery in the Discovery Options.

The sequence of events for a partial discovery is a sub-set of a full discovery:

I. Queues known devices that are enabled for polling.

2. Polls each device with SNMP to discover poll instances. The NetVoyant product queries any
tables that are used by the current datasets for poll instances. Reachability, Availability, and
Interface Statistics are always queried.

Configuration Settings that Affect Discovery and Polling

You can configure how the NetVoyant product discovers your network and polls discovered devices
by performing the following administrative tasks:

Required? Description More information

No Set the discovery options. “Configuring Discovery
You can configure the following: Options™ on page 52

* If and when periodic rediscoveries are performed

* How time-outs and retries are handled during discovery.

* How new devices are named upon discovery.

® The amount of system resources allocated to the
discovery process.

® The default “time-to-live” for unresponsive or out-of-
scope devices

* Event retention and system resource allocation

Yes Add SNMP profiles. “Adding SNMP Profiles to the

Establishing access to the devices on your network from Console” on page 34

the NetVoyant Console depends on creating profiles that it
can use for access and authentication. NetVoyant supports
authentication to devices using SNMPv1, SNMPv2 and

SNMPv3.
No Add discovery scopes. “Configuring the Discovery
The NetVoyant product discovers only networks and Scopes” on page 40

devices included in your discovery scope list.

We highly recommend that you add discovery scopes to
limit the number of devices discovered, especially when
connected to large networks (such as the Internet).

No Add discovery seeds. “Adding Discovery Seeds” on

Seeds are specific devices or networks that the NetVoyant ~ P38¢ 43
product probes during the discovery process to find other
devices and networks to discover.

You do not need to add discovery seeds; however, in some
situations it can be useful to provide these “hints.”
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Required? Description More information

No Enable or disable polling for a device class. “Enabling or Disabling Polling
To control the types of devices from which the NetVoyant for a Device Class” on
poller collects data, you can select which device classes are P8¢ 45
automatically enabled for polling upon discovery.

No Enable or disable polling for a device model. “Enabling or Disabling Polling
To control the types of devices from which the NetVoyant for a Device Model” on
pollet collects data, you can select which device models are ~ P8¢ 64
automatically enabled for polling upon discovery.

No Configure interface types. “Configuring Interface Types”
To control how the NetVoyant product identifies intetfaces % Pag¢ 57
using 1 FType, you can add, edit, or remove interface types
in the NetVoyant Console.

No Enable or disable discovery for a device. “Editing Discovery Settings
You can remove individual devices from the nightly for a Device” on page 150
rediscovery.

You can also set individual devices to extended discovery,
so that they provide further information during the
discovery process to aid the NetVoyant product in finding
other devices and networks to discovet.
No Enable or disable discovery for a dataset. “Managing Discovery for a

You can remove datasets from the full rediscovery.

Dataset” on page 74

Configuring Discovery Options

When the NetVoyant product discovers your network, it finds the SNMP-manageable devices in your

discovery scope. It also discovers which SNMP tables are supported by the discovered devices.
Discovery is based on SNMP and ICMP.

You can configure when it performs rediscovery, how time-outs and retries are handled during

discovery, how it names new devices that it discovers, and the amount of system resources allocated

to the discovery process.

Configuring Periodic Discovery

Periodic discovery, or rediscovery, is enabled by default and configured to occur at a daily interval at

midnight. The NetVoyant product supports the scheduling of both full and partial rediscovery

processes, with a default configuration of a partial rediscovery daily and a full rediscovery weekly. For

more information about the differences between full and partial discovery, see “Using Full and Partial

Discovery” on page 49.

From the Config tab, you can select the Discovery tab in the context panel and enable or disable

periodic rediscovery, as well as modify the interval and timing for both full and partial rediscovery.
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To configure periodic discovery:

I. In the NetVoyant Console (Master or standalone), click the Config tab.

2. Expand the Master and select Discovery.

The discovery options appear in the context panel.

Net\l'oyant Console =] E3 [

File Edit Wew Logs Tools Help

|8+ mm|]7]

xBdr2standup (Master Conzale)
Polling
/Ty Notifications

Dizcovery Scopes
Dizcovery Seeds
Device Models
Device Classes
S8 Irterface Types
SHMP Profiles

ﬁ Schedules

L Traps

|8 xBar2standupy2 (Paller)

i T T S RP U AP

4
W Poling | Motifications  Discovery | scheduies | Traps |

Periodic Discovery

Periodic discovery enabled: r
Thu Jan 21 00:00:00 CST 2010

= L |
= L |

Thu Jan 21 00:00:00 CST 2010

P

Start Full Discovery |

Mext Discovery Time:

Interyal Cffset: Days lJ

Intersal: Days |1

Mext Full Discovery:

Full Discovery Interval:

Start Partial Discovery |

PR i e T e e, O i i . g i e O A i e bt 0 |l

3. Edit the following Periodic Discovery parameters as required:

Parameter

Description

Periodic discovery
enabled

Interval Offset

Interval

Full Discovery
Interval

To turn off automatic rediscovery of your network, clear this check box.

If you turn off rediscovery of your network, any new devices or configuration
changes that you make to existing devices are not reflected in NetVoyant
unless you manually add them.

To configure when the starting point for rediscovery intervals will begin,
select a time in hours, minutes, and seconds for the Interval Offset.

If your NetVoyant system is already running periodic rediscovery (enabled),
changing this setting (time in days, hours, and minutes) will shift the current
discovery interval up or down accordingly.

To configure the frequency at which a partial rediscovery of your devices is
performed, select a time in days, hours, minutes, and seconds for the Interval.

By default, the NetVoyant product performs a partial rediscovery daily (an
interval of 1 day and 00:00).

To configure the frequency at which a full rediscovery of your devices is
performed, select the number of days for the interval.

By default, the NetVoyant product performs a full rediscovery weekly (an
interval of 7 days).

4. Click Set to save your changes.

Note: You can manually execute a full or partial rediscovery of your entire network. For a full

rediscovery, click Start Full Discovery. For a partial rediscovery, click Start Partial Discovery.
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Configuring the Discovery Parameters

Use the Discovery Parameters to specify how rediscovery of your network is executed on your

NetVoyant system and how the NetVoyant product manages previously discovered devices that are

unresponsive, as well as devices that do not fully support SNMP polling or are currently out of scope.

To configure discovery parameters:

I. In the NetVoyant Console (master or standalone), click the Config tab.

2. Expand the Master Console and select Discovery.

The discovery options appear in the context panel.

Timeout (zec):
Retries:

Ping Sweep:
MPC Sync:

Device Expiration (days):
Device Unresponsive (days):

lgnore Mon-SHMP Devices:
Detect Out-of-Scope Devices:

|-Discovery Parameters—

e T S S s T e e T

P PP

3. Scroll if necessary and edit the following Discovery Parameters as required:

Parameter

Description

Timeout (sec)

Retries

Ping Sweep

NPC Sync

Enter a length of time in seconds to configure how sensitive the NetVoyant
product is to time-outs when performing SNMP queries to your devices during
discovery.

Longer time-outs significantly increase how long it takes to complete the
discovery process.

Note: You can also configure time-outs and retries for individual devices. For
more information, see “Editing Discovery Settings for a Device” on page 150.

Enter the number of times that you want to retry each device for each SNMP
profile when a timeout occurs.

More retries can significantly increase how long it takes to complete the
discovery process.

Note: You can also configure time-outs and retries for individual devices. For
more information, see “Editing Discovery Settings for a Device” on page 150.

Clear this check box to disable ping sweeps during rediscovery.

If ping sweeps are disabled, the NetVoyant product uses directed broadcasts
during rediscovery to create a list of devices to discover.

Note: As directed broadcast is often disabled in routets, it is recommended
that you use ping sweep for the initial discovery of your network.

Select this check box to enable the NetVoyant product to regularly synchronize
data with NetQoS Performance Center.

Note: NetVoyant and either ReporterAnalyzer or SuperAgent must be added
as data sources in the NetQoS Performance Center for this feature to function.
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Parameter

Description

Device Expiration
(days)

Device
Unresponsive (days)

Ignore Non-SNMP
Devices

Detect Out-of-
Scope Devices

Modify this setting to change the number of days that a device remains in the
system when it enters one of the states (Out-of-Scope, Does Not Resolve, or
Unresponsive) that triggers a “time-to-live” expiration.

When the number of days has transpired, the device is automatically removed
at the next discovery process unless its state has changed.

For more information about poll status for devices, see “Device Polling Status”
on page 131.

Modify this setting to change the number of consecutive, non-responsive days
required for NetVoyant to set the device to an Unresponsive status, and trigger
a “time-to-live” expiration.

If the device responds before the expiration period, it will be returned to its
previous status.

For more information about poll status for devices, see “Device Polling Status”
on page 131.

Select this check box to ignore all non-SNMP devices that are not explicitly
scoped.

By default, NetVoyant discovers all devices in a scope. If a device is not SNMP-
capable, NetVoyant adds the device to the database and creates a Reachability
poll table (poll instance) to enable a PING of the device and to obtain latency
measurements.

To specifically add a non-SNMP device to the scope when this option is
selected, add the device address and mask, for example:

192.168.123.1 255.255.255.255

For more information about defining and using discovery scopes, see
“Configuring the Discovery Scopes” on page 40.

Select this check box to retest out-of-scope devices during the “time-to-live”

petiod.

If an out-of-scope device is determined to be in scope during that time,
NetVoyant returns the device to its previous status.

This check box is selected by default; however, if you do not want to rediscover
out-of-scope devices even if they ate added to the discovery scope
configuration, you can clear this check box so that NetVoyant will continue to
expire all out-of-scope devices according to the Device Expiration setting.

For more information about defining and using discovery scopes, see
“Configuring the Discovery Scopes” on page 40.

4. Click Set to save your changes.
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Configuring the Device Naming Parameters

Use the Device Naming Parameters to specify how NetVoyant names the devices that it discovers on
your network. Setting the naming parameters determines how devices appear in the NetVoyant
Console and in reports.

To configure device naming parameters:
I. In the NetVoyant Console (master or standalone), click the Config tab.
2. Expand the Master Console and select Discovery.

The discovery options appear in the context panel.

g e g R g P TS e e e e

[Device Naming Parameters—

Default device name: IIP Address I
Default device alias: ISNMP Syshame T |

DMS domain(s] to remove from aliss: I

3. Scroll if necessary and edit the following Device Naming Parameters as needed:

Parameter Description

Default device name  Use the drop-down menu to select a default device name for your discovered
devices using the IP address, DNS name, or SNMP sysName OID.

Note: The device name is used to poll the device; therefore, this must be an
IP address or a name that resolves to an IP address. Before selecting the
SNMP Sysname option, ensure that your devices ate set up so that the SNMP
sysName resolves in DNS to an IP address.

Default device alias Use the drop-down menu to select a default device alias for your discovered
devices using the IP address, DNS name, or SNMP sysName OID.

This is for display purposes and is the device alias that you see in the
NetVoyant Console and for reporting. If you choose to use the sysName
OID, the NetVoyant Console will use the device’s DNS name or IP address
for devices that do not have a sysName value.

DNS domain(s) to To remove the domain portion of your devices’ name for display purposes in
remove from alias NetVoyant reports ot in the Console, enter a comma-separated list of domain
names in this field.

For example, you could entet a domain of example . com. If NetVoyant
discovers a device with a domain name of device5.example.com, it
strips the domain suffix (example .com) from the device name. In the
NetVoyant Console, the device is named device5.

4. Click Set to save your changes.
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Configuring the System Resources Parameters

Use the System Resources Parameters in the Discovery tab to specify how the NetVoyant product
handles event retention and system bandwidth during rediscovery.

To configure system resource parameters:
I. In the NetVoyant Console (Master or standalone), click the Config tab.
2. Expand the Master server and select Discovery.

The discovery options appear in the context panel.

S S S S S S S SO S oy S YOS S o)
System Resources
Evert Retention (day=): I;' 3:

Resource Usage:

Lowy (Sloweer) '—J— High (Faster)

adimum Bandwicith:
& Unlimited Limited (KE): I

R = e T R S

3. Scroll if necessary and edit the following System Resources parameters as required:

Parameter Description
Event Retention To control how long topology change logs are retained, set the number of
(days) days in this field. In distributed systems, pollers retain any polling changes for

the length of time indicated here.

If a poller loses connectivity with the Mastet, topology change logs enable it
to communicate topology changes that it discovers during this lapse in
connectivity.

Resource Usage To configure how many process threads and memory is allocated to the
discovery process, change the slide bar setting for Resource Usage.

Low (Slower) values are the minimum values for these resources
recommended for discovery to occur. A low value results in a slower
discovery process. A high value results in a faster discovery process, but could
impact reporting processes because of memory allocation.

Maximum Bandwidth  To restrict the amount of bandwidth that is allocated for the discovery
process, select Limited and enter a maximum bandwidth in KB. By default,
discovery is not restricted by bandwidth.

4. Click Set to save your changes.

Configuring Interface Types

The NetVoyant product has a preconfigured list of known interface types; however, you can add new
interface types, change the identifying value for existing interface types, or completely remove
interface types. To control how it identifies interfaces by 1¥Type, you can add, edit, or remove
interface types in the NetVoyant Console.

To add or edit an interface type:
I. In the NetVoyant Console (Master or standalone), click the Config tab.

2. Expand the Master server.
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3. Expand Discovery and select Interface Types.

Dizcovery Scopes

| | Nisrnvery Seeds
[ Paolling Device Models Device Classes Interface Types r SNWP Profiles
/Ty Notifications
= E';l:l_ Dizcovery Interface description | “alug |
Discovery Scopes B3 other 1 ﬂ
Discavery Seeds B regularigzz 2
Dievice Models B hdhl1822 3
Device Classes B ddn-x24 4
ER rfeo77-x25 5
SNMP Profiles B ethernet-csmacd 4
€ schedules B is088023-csmacd 7
¥ Traps B is088024-tokenBus g
ol B4 2standupy (Poller) B iso88025-tokenRing @
H i5088026-man 10
BB starLan 1
E protean-10Mbit 12
E proteon-80Mbit 13
BB hwnarrhannal 14 LI
Al | Change | Remove | Help |

Group  Config | MlBSI Servicesl

4. In the context panel, do one of the following:
= To add a new interface type, click Add. This opens the Add Interface Type dialog box.

= To edit an existing interface type, select the interface type and click Change. This opens the
Change Interface Type dialog box.

Interface type: Ids1
Walue: |1 g
OK I Cancel |

5. Enter or edit the following parameters as required:

Parameter Description

Interface type For a new interface type, enter the name of the interface type in the Interface

type field.

Value Enter or edit the value for the Interface type. This is the value used in the
ifType OID (or similar).

6. Click OK.

The NetVoyant product discovers new devices interface type according to your changes.

To remove an interface type:

I. In the NetVoyant Console (master or standalone), click the Config tab.
2. Expand the Master Console.

3. Expand Discovery and sclect Interface Types.

4. In the context panel, select the interface type from the list.

5. Click Remove.

6. In the confirmation dialog box, click Yes.
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Eonfirm Interface type Remove [ %]

[

1

Are you sure’?

% Removing Interface type: sixToFour

CONFIGURING DEVICE CLASSES AND MODELS

The NetVoyant product determines the model of a device that it discovers by looking at the device’s
sysObjectlID. It then determines the class of the device based on the device model.

As an administrator, you can configure how the NetVoyant product classifies discovered devices and

enables polling of newly-discovered devices by performing the following tasks:

Task

Purpose

More information

Add a device class.

Remove a device class.

Add, edit, or remove a
device model.

Enable or disable
polling for a device
class.

Enable or disable
polling for a device
model.

To control how the NetVoyant product
identifies devices by class.

To control how the NetVoyant product
identifies devices by class.

To control how the NetVoyant product
identifies devices by model.

To control the types of devices from which the
NetVoyant poller automatically collects data.

To control the types of devices from which the
NetVoyant poller automatically collects data.

“Changing a Device’s
Classification” on page 61
“Removing a Device Class”
on page 62

“Adding or Editing a Device
Model” on page 63

“Enabling or Disabling
Polling for a Device Class”
on page 45

“Enabling or Disabling
Polling for a Device Model”
on page 64
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NetVoyant Device Classifications

The NetVoyant product automatically classifies new devices it discovers according to device model
and class. Device classification helps determine the appropriate device group for each new device. For
example, it places a device identified as a router in the Routers group.

Device class and model information also determine whether the NetVoyant product automatically
enables or disables polling for new devices. You can disable polling for device classes or models to
control how it gathers information from your network. And you can select the device models or
classes that it automatically enables for polling upon discovery.

Default Device Classes

The NetVoyant product includes a preconfigured list of known device models and their related
sysObjectlDs; however, you can add new device models, change the class or sysObjectlID for
device models, or completely remove device models to control how the NetVoyant product classifies
new devices that it discovers.

Default device classes include the following:

e Other

= Routers

e Hubs

e DProbes

e Servers

e Workstations

e Printers

e Switches

* Network Termination

e Firewalls

The “Other’” Device Class

The NetVoyant product places all devices that it does not recognize as an identified device class in the
Other device class. This happens when one of the following is true:

e The device is a model that it does not recognize.

* You removed the device class to which the device model belongs.

Warning: Do not remove the “Other” device class.
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help the NetVoyant product classify devices better, you can:

Add device classes and assign device models to that class. For more information, see “Changing a
Device’s Classification” on page 61.

Add device models to the NetVoyant Console and assign them to appropriate device classes. For
more information, see “Adding or Editing a Device Model” on page 63.

Changing a Device’s Classification

You can change the device class assigned by the NetVoyant product. For example, if it assigned a

router in the Other device class, you can manually re-assign it to the correct Routers device class for

that device model.

Note: You cannot change the device class for a generic device model. Devices with a sysObjectlID

such as 1.3.6.1.4.1.x, or with the term “generic” in the Device Model Name typically fall into this

category.

To change the device class for a device model:

l.
2,

In the NetVoyant Console (Master or standalone), click the Config tab.
Expand the Master server.
Expand Discovery and select Device Models.

Perform one of the following actions:

= To add a device model and assign it to a device class, click Add.

= To edit an existing device model and assign it to another device class, select the device model
and click Change.

Alternatively, you can select a mis-classified device in the Group tab, right-click, and select Change
Classification from the pop-up menu.

The Device Classification dialog box opens.
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A vevice Classification for 1.3.6.1.4.1.9.1.4

Device Model sysChjectiD: 136141914
Device Class: Fouters LI
Device Model hame: CizcoProtocolTranslatar

Manufacturer's Image File (Optional);  |Cisco

Ok I Cancel | Help |

5. Enter or edit the following parameters:

Parameter Description

Device Model sysObjectID  For a new device model, enter the sysObjectID.

The device’s SNMP agent uniquely identifies the device model using the
sysObjectID. See your device’s documentation to locate this number.

Device Class Select the new Device Class; for example, Routers.

Device Model Name The Device Model Name refers to the equipment model’s name. For
example, HP Laser]et Printer.

Manufacturer’s Image File  (Optional) Enter the name of the device manufacturer’s image file to
control the icon that the NetVoyant Console displays for devices of this
model on the Group tab.

If you do not enter a custom image file, it displays the default icon for

the device class.

Note: Place the GIF image in the
D:\NetVoyant\classes\redpoint\images directory on the
NetVoyant server.

6. When you are finished defining or editing the device model, click OK.
This creates the new device class and assigns this device model to the device class.
7. Repeat step 3 through 5 to assign more device models to the device class.

After the initial device, when editing a device model, you can select the new device class from the
Device Class list.

8. To view the device class, click the Device Class tab.

Removing a Device Class

If you remove a device class, the NetVoyant product defines all devices of this class as part of the
Other device class and continues to poll devices in this device class that are not disabled from polling.
Later, if you want to add the device class back into the NetVoyant product, you must manually
recreate the device class by adding a new device class and reassigning device models.

Warning: It is strongly recommended that you do not remove device classes from the NetVoyant
product. If you do not want the NetVoyant product to poll a device class, perform the following tasks
instead of removing the device class:
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Task More Information

Disable the device class from polling so that new devices “Enabling or Disabling Polling for a Device
in this device class are disabled from polling, Class” on page 45

Disable polling of all datasets for the device group that “Configuring Polling for a Group” on
contains this device class so that current devices in this page 123

device class are disabled from polling.

Important: Before removing a device class, assign each device model in the class to a different device

class.

To remove a device class from NetVoyant:

l.
2.
3.

In the NetVoyant Console (Master or standalone), click the Config tab.
Expand the Master server.

Expand Discovery and sclect Device Classes.

In the list of device classes, select the device class and click Remove.

The NetVoyant product removes the device class and assigns all device models in this device class
to the Other device class.

Adding or Editing a Device Model

The NetVoyant product includes a preconfigured list of known device models; however, you can

control how it identifies devices by model. You can add, edit, or remove device models in the

NetVoyant Console by performing the following tasks:

Add new device models. To add a new device model, you must know the associated
sysObjectlID. The device’s SNMP agent uniquely identifies the device model using the
sysObjectlD. See your device’s documentation to locate this number.

Change the class or sysObjectID for device models.
Change how device models are placed into NetVoyant groups.

Remove device models. It is recommended that you do not remove device models from the
NetVoyant product. If you remove a device model, it defines all devices of this model as part of
the Other device class. If you later want to add the device model back into the NetVoyant product,
you must manually recreate the device model using the sysObjectID.

To add or edit a device model:

. In the NetVoyant Console, click the Config tab.

Expand the Master Console, expand Discovery, and sclect Device Models.

. Perform one of the following actions:

e To add a new device model, click Add.

= To edit an existing device model, select the device model and click Change.

The Device Classification dialog box opens.
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A vevice Classification for 1.3.6.1.4.1.9.1.4

Device Model sysChjectiD: 136141914
Device Class: Fouters LI
Device Model hame: CizcoProtocolTranslatar

Manufacturer's Image File (Optional);  |Cisco

Ok I Cancel | Help |

4. Enter or edit the following parameters:

Parameter Description

Device Model sysObjectlD  For a new device model, enter the sysObjectID.

The device’s SNMP agent uniquely identifies the device model using the
sysObjectlID. See your device’s documentation to locate this

number.
Device Class Select the Device Class for this device model; for example, Routers.
Device Model Name The Device Model Name refers to the equipment model’s name; for

example, HP Laser]et Printer.

Manufacturer’s Image File  (Optional) Enter the name of the device manufacturer’s image file to
control the icon that the NetVoyant product displays for devices of this
model on the Group tab.

If you do not enter a custom image file, it displays the default icon for
the device class.

Note: Place the GIF image file in the

D:\NetVoyant\classes\redpoint\images directory on the
NetVoyant server.

5. When you finish defining or editing the device model, click OK.

Warning: It is strongly recommended that you do not remove device models from the
NetVoyant product. If you remove a device model, the NetVoyant product defines all devices of this
model as part of the “Other” device class. If you later want to add the device model back into the
NetVoyant product, you must manually recreate the device model using the sysObjectlID.

Enabling or Disabling Polling for a Device Model

To control the types of devices from which the NetVoyant product collects data, you can select which
device classes and device models are automatically enabled for polling upon discovery. The
NetVoyant product discovers all devices within your discovery scope; however, it does not
automatically enable polling for those device classes or models that you choose to exclude from
polling. It does not gather data from these devices unless you specifically enable polling for them after
discovery.

Note: Enabling or disabling polling for a device model does not affect polling for devices that the
NetVoyant product has already discovered. When you disable a device model, it disables polling for
new devices of this model when they are discovered. When you enable a device model, it enables
polling for new devices of this model when they are discovered.
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To select the device models that are polled:

I. In the NetVoyant Console, click the Config tab.

2.

Expand the Master server and select Discovery beneath it.

Select Device Models.

. Perform the following tasks to designate which models are enabled for polling:

= To turn off polling, clear the Enabled check box next to the device model name.

= To turn on polling for a device model that is disabled, select the Enabled check box.
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TROUBLESHOOTING NETVOYANT CONFIGURATION

The following questions and answers address some of the issues that might arise during NetVoyant
configuration and discovery.

Q. The NetVoyant product did not discover devices. What’s wrong?
A. The following are some possible reasons why the NetVoyant product does not discover devices:

= You did not enter the correct SNMP profile information for your SNMP agents. For more
information, see “Adding SNMP Profiles to the Console” on page 34.

= Your devices might require that SNMP pollers be added to their access control list. For more
information, see the next question and answer.

= You did not enter a correct discovery scope. The addresses and masks might be too restrictive. For
more information, see “Configuring the Discovery Scopes™ on page 40.

= You might need to increase the timeout or retries for discovery. For more information, see
“Configuring Discovery Options” on page 52.

= You might have discovered devices, but not enabled them for polling, If you are not seeing some
of your devices in the NetVoyant Console, you might not be showing devices that are disabled for
polling. For more information, see “Enabling and Disabling Polling” on page 85.
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Q. What is a Device Access Control List?

A. Many routers and other network connectivity devices require that the address of SNMP pollers be
entered into the device’s access control list.

The access control list typically contains a list of trusted hosts that the device responds to using
SNMP. You might need to add the NetVoyant poller that polls a device (distributed) or the Master
Console (standalone) to the access control list for the device. Configuration of the access control list
is typically performed using a proprietary interface to the router. Please check your device’s
documentation for assistance with this task.

Q. | completed the Configuration Wizard. Why is there no data available in NetVoyant reports?

A. The NetVoyant product does not collect data until the first polling cycle is initiated. The rolled up
data that is presented in NetVoyant reports is generally not available until two rollup periods have
passed (two hours by default).

The following are additional possible reasons that you do not see data:

= All of your poll instances are disabled. The NetVoyant product only collects data for enabled poll
instances. For more information, see “Configuring Polling for Poll Instances and Interfaces” on
page 166.

= You might need to increase the SNMP timeout and retries for certain devices, such as devices
across a slow WAN link. For more information, see “Editing Discovery Settings for a Device” on
page 150.
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CHAPTER 3

Configuring Data Collection
and Retention

The NetVoyant product organizes data that it collects from your devices and determines how it

collects that data according to datasets. Each dataset is based on exactly one MIB table, from which

data for that dataset is collected. In the NetVoyant Console, you configure polling, data retention, and

baselines by dataset.

The NetVoyant product is pre-configured with many general-purpose datasets. These include Device
Availability, Interface Statistics, Frame Relay Circuit Statistics, T1, T3, Cisco System Resources, Host

Resource Storage, and others.

This chapter covers the following topics:

“NetVoyant Data Collection and Storage” on page 68
“Managing Dataset Properties” on page 71

“Creating and Configuring Custom Datasets” on page 80
“Configuring Data Collection Frequency” on page 94
“Configuring Data Rollup and Retention” on page 99
“Configuring What Data to Gather” on page 104
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NETVOYANT DATA COLLECTION AND STORAGE

The NetVoyant product organizes data that it collects from your managed devices according to
datasets. It correlates each dataset with a MIB table and stores data that it gathers from a MIB table in
a poll table in the correlated dataset.

For example, the NetVoyant Topology service obtains information for the Host Resource Storage
dataset from the hrStorageEntry table, which is defined in the Host Resources MIB. If it polls a
server for data stored in the hrStorageEntry MIB table, it stores the collected data in the Storage
poll table in the Host Resource Storage dataset.

Data Organization by Poll Instance

A MIB uses object identifiers (OIDs) to label each type of data that it describes. An OID is a
permanent, unique name assigned to an object for storage (persistence).

When the NetVoyant Topology service gathers data from a device, it correlates all OID-labeled data
for one managed object with one poll instance. If it gathers data from your server that supports the
Host Resources MIB, it correlates data for all OIDs in that MIB (hrStorgeSize, hrStorageUsed,
hrStorageAl locationFai lures) for one hard drive with one poll instance. The NetVoyant
product correlates all data for all OIDs for another hard drive with a separate poll instance. If a device
collects data for a polled MIB table from four managed objects, it has four correlated poll instances.

The following diagram provides a visual representation of how the NetVoyant product gathers data
from a MIB table on a device and organizes it by poll instance, poll table, and dataset.

NetVoyant data is organized by dataset, poll table, and poll instance.

MNetVaoyant Managed Device

Poll Table
Poll Instance 1 Managed Object 1

SMMP ID
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( oID1 (
( (
( (
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Viewing and Configuring Data by Poll Instance

The NetVoyant product organizes poll instances and poll tables in the NetVoyant Console so that you
can view your data organized by device, poll table, and poll instance. If a device supports a MIB table
that is correlated with a dataset in the NetVoyant product, then it displays a poll table with poll
instances for that dataset below the device on the Group tab of the NetVoyant Console.

For example, if a server supports the Host Resources MIB, the server displays a poll table called
Storage when you select the server in the Group tab of the NetVoyant Console and expand it. This
poll table contains several poll instances, each representing the data collected from a managed object
on the server.

Poll instances in the Storage poll table for the ngmediastream server

nojfs ;I
= ] nomediastream

Bvailability
Reachability Statistics
Interfaces

Device Status/Errars

¥ CoiLabel Serial Mumber d86e03de
i Jwdl
9 Wirtual Mermory

¥ Physical Memary

-] oo
H nojoz

i Jod
H perception

| Group I Configl MIBSI Servicesl

If you want to configure how the NetVoyant product collects a certain type of data for a managed
object on a device, you can configure settings for the related poll instance. For example, you could
apply a polling group with a five minute polling rate to the Virtual Memory poll instance shown in the
preceding figure. The NetVoyant product then gathers data about Virtual Memory from the
hrStorageEntry MIB table on the ngmediastream server every five minutes.

In the NetVoyant product, you configure polling, data retention, baselines, and data validation by
dataset. To configure how it gathers and stores data, you can perform the following tasks:

Task type Task specifics More information

Edit an existing dataset. Edit configuration options for an existing “Managing Dataset
dataset. Properties” on page 71

Create a custom dataset To add functionality by compiling additional “Creating and Configuring
MIBs into the NetVoyant product, you must Custom Datasets” on
also create custom datasets in the NetVoyant page 80

Console based on the MIB tables from which
you want to gather data.
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Task type Task specifics More information
Configure what data the ~ Create or edit the expressions that are gathered ~ “Creating or Editing a
NetVoyant product from the MIB table for the dataset. Dataset Expression” on
gathers for a dataset. page 105

Add or edit baselines for the expressions in the ~ “Adding and Editing
dataset. Baselines in the NetVoyant
Console” on page 108

Create data validation rules to ensure the “Using Data Validation
integrity of the data. Rules” on page 112
Configure the frequency  Create or edit polling groups that can be “Creating or Editing a
for gathering the data for  applied to poll instances in the dataset. Polling Group” on page 94
a dataset. Set a default polling group for the dataset. “Changing the Default
Polling Group for a Dataset”
on page 96
Modify the polling intervals used by the poll “Configuring the Frequency
instances in the dataset. for Polling and Rollups” on
page 94

Configure how long the Editing the rollup frequency or retention time “Configuring Data Rollup
NetVoyant database for data in the dataset by editing the rollup and Retention” on page 99
retains data for a dataset.  settings for the dataset’s polling groups.
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MANAGING DATASET PROPERTIES

You can configure basic parameters for a dataset such as the description of the dataset that is visible in
the NetVoyant Console. You can also enable or disable discovery for a dataset and configure how the
NetVoyant system discovers and names poll instances in a dataset.

View the list of existing datasets on the Master server (or a standalone) by selecting the Config tab and
expanding Polling > Datasets.
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Note: If you have a distributed NetVoyant system, all changes to datasets must be done on the
Master.

Editing Dataset Details

The Dataset panel contains a number of settings for the dataset. These settings determine whether
the NetVoyant system polls for the dataset, how it discovers and enables new poll instances for the
dataset, and handling of polling events associated with the dataset. You can modify the settings for a
default dataset or for custom datasets that you have created.

To edit detail settings for an existing dataset:

I. In the Config tab of the NetVoyant Console (Master or standalone), expand the Master server.
2. Expand Polling > Datasets and select the dataset.

The dataset’s details appear in the context panel.
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3. Enter or edit the following parameters:

Parameter

Description

Description

Polling Enabled

Periodic discovery
enabled

Model

Poll Event Severity

(Optional) Enter or edit the description of the dataset.

Select this check box to enable polling for the dataset.

Clear the check box to disable polling for the dataset.

For more information, see “Enabling and Disabling Polling for Datasets” on
page 86.

Select this check box to enable discovety for the dataset.

For more information, see “Managing Discovery for a Dataset” on page 74.
(Optional) Use this parameter to specify a string for selective discovery of
pollinstances. When specified, only devices with a matching SysObjectlD
are queried by the NetVoyant system to discover new poll instances.

For more information, see “Selective Discovery by Device ID”” on page 75.
Note: Some standard datasets do not honer this setting and some others

have a required setting. In these cases, the string cannot be specified or
changed.

Select a severity level from the list to control the severity that is assigned to
polling failures for this dataset. The default setting for most datasets is
Unavailable, to indicate that the device was unavailable for polling.

If the NetVoyant product is not able to poll a device that supports the data in
this dataset, it assigns the poll event severity for the dataset to this event and
sends notifications that you have configured for poll events of this severity
level.

Note: If your NetVoyant system is registered with the NetQoS Performance
Center as a data source, this severity level is reported in the Map and Map
Event List.
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Parameter Description
Poll Event Category Use this setting to assign a category for poll events associated with the
dataset.

Note: If your NetVoyant system is registered with the NetQoS Performance
Center as a data source, this category is used to filter events in the Map and
Map Event List.

Data Validation Use this drop-down list to set the severity associated with data validation log

Severity messages. Set this to None to turn off the logging of these messages for the
dataset.

Polling Notification (Optional) Enter the number of poll cycles for which the NetVoyant product

Limit is able to send a notification for a polling alarm. For more information, see

“Using Polling Notification Limits” on page 249.

Note: Setting a larger number of poll cycles raises the amount of traffic
between the NetVoyant Polling and Notify services and the amount of
database records required for exception reports. For more information about
NetVoyant services, see “Managing NetVoyant Services” on page 279.

Auto-enable Rule (Optional) Select whether you want to restrict polling on discovered poll
instances in this dataset based on an auto-enable polling rule.

This option is only configurable if you have created auto-enable polling rules
for the dataset. For more information, see “Using Auto-Enable Polling” on
page 88.

Note: Auto-enable polling rules are created by default for the Interface
Statistics dataset.

Discovery Rule (Optional) Set this option if you want to restrict discovery of poll instances
for the dataset based on a discovery rule. The default setting, All, indicates
that no discovery rules are applied and all poll instances are discovered.

This option is only configurable if you have created discovery rules for the
dataset. For more information, see “Selective Discovery by Poll Instance” on
page 76.

Storage Requirement  (Optional) Enter an expression to dynamically restrict database storage for
poll instances in the dataset.

For more information, see “Restricting Database Storage” on page 103.

Poll Instance Name (Optional) Enter the default name for poll instances in this dataset. You can
use any OIDs in the MIB table for the dataset to create dynamically
generated poll instance names.

For more information, see “Naming Poll Instances and Interfaces” on

page 78.
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Parameter Description
Poll Instance (Optional) Enter the default description for poll instances in this dataset. You
Description can use any OIDs in the MIB table for the dataset to create dynamically

generated poll instance descriptions.

For more information, see “Naming Poll Instances and Interfaces” on

page 78.
Poll Instance Modity this setting to change the number of days that a poll instance for the
Expiration (days) dataset remains in the system when it is scheduled to be deleted (“time-to-

live” expiration).When the number of days has transpired, the poll instance is
automatically removed at the next discovery cycle unless its state has
changed.

For more information, see “Polling Status and Expiration” on page 161.

4. Click Set to save your changes to the dataset.

Managing Discovery for a Dataset

By default, all datasets are included in rediscovery. If you do not want to discover any new poll
instances for a dataset, you can disable discovery for that dataset. If you do not want to gather any
data associated with a particular dataset, including existing poll instances, you can also disable polling
of the dataset. For more information about disabling polling for the dataset, see “Enabling and
Disabling Polling for Datasets” on page 86.

When a dataset is enabled for discovery, the NetVoyant system discovers all poll instances and
interfaces on all discovered devices. However, you can implement selective discovery to control which
datasets are tested against a device during discovery.

In the NetVoyant Console, you can also control how the NetVoyant system names the discovered poll
instances and interfaces.

Enabling and Disabling Dataset Discovery

To remove a dataset from automatic rediscovery, you can disable discovery on the dataset’s Details
tab. If you disable discovery, the NetVoyant product does not queue or update information related to
this dataset during periodic rediscovery.

To enable or disable discovery for a dataset:
I. In the Config tab of the NetVoyant Console, expand the Master Console.
2. Expand Polling > Datasets and select the dataset.

The dataset’s details appear in the context panel.

3. Change the option selection to enable or disable periodic discovery:
= To disable the dataset for discovery, clear the Periodic discovery enabled check box.

= To enable the dataset for discovery, select the Periodic discovery enabled check box.
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4. Click Set at the bottom of the context panel to apply your changes.

Selective Discovery by Device ID

In the NetVoyant Console, the Dataset tab for a selected dataset displays a Model parameter. This
parameter controls which devices are tested against the dataset during discovery. When this parameter
contains a specified string, only those devices with a matching sysObjectID will be queried for poll
instances for the dataset.

This parameter takes a single entry (multiple entries cannot be specified) as a free-format string and
the NetVoyant Console does not perform any specific data validation. If the specified string does not
match the device’s sysObjectlD, or the beginning of its sysObjectlD, the discovery of the dataset
is skipped for that device.

Some of the more global datasets, such as Device Availability, Reachability, and Interface Statistics, do
not honor this setting and a string cannot be specified. For other datasets where the NetVoyant
product utilizes custom discovery code (such as NBAR and Cisco CB QoS), this parameter is ignored.

There are some standard datasets that are specific to Cisco MIBs (IPSLA, Memory Pool, System, and
Backplane) where the model is already specified and cannot be modified. For example, in the Cisco
Backplane Traffic dataset, only devices that have a SysObjectlD starting with 1.3.6.1.4.1.9 are
queried for sysTrafficMeterEntry poll instances. The result is that non-Cisco devices are not
tested for this dataset.
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Use this parameter to optimize the discovery process, particularly for custom datasets (MIBs) built for
specific types of devices (such as F5, Nortel, and so on).

Important: Exercise caution when specifying a Model ID for common datasets. For example, it does
not make sense to define an ID for the Frame Relay Circuit Statistics dataset because many different
vendors support the standard Frame Relay MIB; however, the NetVoyant Console does allow an ID
specification for this dataset, and if specified, it will be used.
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Selective Discovery by Poll Instance

In the NetVoyant Console, you can configure discovery rules for a dataset to control which poll
instances are discovered based on OID variables. These discovery rules take the form of a ““where”
clause; for example, you could add the following clause as a discovery rule for the Interface Statistics
(ifstats) dataset to limit discovery to certain types of interfaces:

ifType in (6, 20, 18, 45)
Adding a Discovery Rule

You can add multiple discovery rules for a dataset on the Discovery Rules tab. Each rule is comprised
of an SNMP requirement as an expression.

To create and apply a discovery rule for a dataset:
I. In the NetVoyant Console, expand the Master Console on the Config tab.
2. Expand Polling > Datasets and select the dataset.
The details for the dataset appear in the context panel.
3. Click the Discovery Rules tab.
4. Click Add to add a rule for discovering poll instances or interfaces for that dataset.

This opens the Add Expression dialog box.

Mame: | oIDs | syntax |
Operators: chidosREDRandomDr ... Counter32 -
+ - * ! ch@osREDRandomDr ... Courter32
0 y . - ch@osREDRandomDr ... Courtertd
ch@osREDRandomDr ... Courter32
== == AND QR chQosREDRandomDr .. Courter32
LIKE MOT LIKE ch@osREDRandomDr ... Courtertd LI

SHMP Reguirement:

| v

4|

Property Reguirement:

| v

Ll

Ok I test | Clear | Cancel | Apply | Help |

5. In the Name field, enter a descriptive name for the rule.

6. In the SNMP Requirement field, enter an expression that defines the discovery rule where the
expression evaluates as true or false.

When the discovery rule is applied to the dataset, the NetVoyant Console limits discovery to those
poll instances and interfaces for which the rule evaluates to true. For more information about
constructing valid discovery rules, see the following section.

7. Click OK to add the rule name and expression to the Discovery Rules list for the dataset.
8. Click the Datasets tab to view the dataset’s details in the context panel.

9. From the D